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Accessibility Statement

BCcampus Open Education believes that education must be available to everyone which means
supporting the creation of free, open, and accessible educational resources. We are actively committed
to increasing the accessibility and usability of the textbooks we produce.

Accessibility features of the web version of this resource

The web version of Key Concepts of Computer Studies has been designed with accessibility in mind by
incorporating the following features:

+ It has been optimized for people who use screen-reader technology.
o all content can be navigated using a keyboard
o links, headings, and tables use proper markup
o all images that convey information have text descriptions

+ Information is not conveyed by colour alone.

Other file formats available

In addition to the web version, this book is available in a number of file formats, including PDF, EPUB
(for eReaders), MOBI (for Kindles), and various editable files. Here is a link to where you can
download this book in another file format. L.ook for the “Download this book” drop-down menu to
select the file type you want.

This book occasionally links to external websites. For those using a print copy of this resource, the link
text is underlined, and you can find the web addresses for all links in parentheses.

Known accessibility issues and areas for improvement

While we strive to ensure that this resource is as accessible and usable as possible, we might not always
get it right. Any issues we identify will be listed below.

There are currently no known issues.

Accessibility standards

The web version of this resource has been designed to meet Web Content Accessibility Guidelines 2.0,
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level AA. In addition, it follows all guidelines in Appendix A: Checklist for Accessibility. The
development of this toolkit involved working with students with various print disabilities who provided
their personal perspectives and helped test the content.

Let us know if you are having problems accessing this resource

We are always looking for ways to make our resources more accessible. If you have problems
accessing this resource, please contact us to let us know so we can fix the issue.

Please include the following information:

* The location of the problem by providing a web address or page description
* A description of the problem

» The computer, software, browser, and any assistive technology you are using that can help us
diagnose and solve your issue

o e.g., Windows 10, Google Chrome (Version 65.0.3325.181), NVDA screen reader

You can contact us one of the following ways:

» Contact form; BCcampus Support

* Web form: Report an Open Textbook Error

This statement was last updated on November 27, 2020.
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For Students: How to Access and Use this Book

This textbook is available in the following formats:

* Online webbook. You can read this book online on a computer or mobile device in one of
the following browsers: Chrome, Firefox, Edge, and Safari.

* PDF. You can download this book as a PDF to read on a computer (Digital PDF) or print it
out (Print PDF).

* Mobile. If you want to read this textbook on your phone or tablet offline, you can use the
EPUB (eReader) or MOBI (Kindle) files.

« HTML. An HTML file can be opened in a browser. It has very little style so it doesn’t look
very nice, but some people might find it useful.

You can access the online webbook and download any of the formats for free here: Key Concepts of
Computer Studies. To download the book in a different format, look for the “Download this book”
drop-down menu and select the file type you want.

How can I use the different formats?

Internet Screen
Format . Device Required apps Features reader
required? .
compatible
Online Computer, | An internet browser Option to enlarge text and
Yes tablet, (Chrome, Firefox, Edge, | compatible with browser Yes
webbook -
phone or Safari) text-to-speech tools.
PDF No Cgmputer, Adobe Reader Ability to zoom in, highlight, Unsure
print copy and annotate the text.
EPUB Computer, Kindle app (MOBI) or Option to enlarge text, change
and No tablet, eReader app (EPUB) font style, size, and colour Unsure
MOBI phone pp yie ’ ’
Computer, | An internet browser Option to enlarge text and
HTML No tablet, (Chrome, Firefox, Edge, | compatible with browser Yes
phone or Safari) text-to-speech tools.

Tips for Using This Textbook

» Search the textbook.

o If using the online webbook, you can use the search bar in the top right corner to
search the entire book for a key word or phrase. To search a specific chapter, open
that chapter and use your browser’s search feature by hitting [Cntr] + [f] (PC) or
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[Command] + [f] (Mac).

o The [Cntr] + [f] and [Command] + [f] keys will also allow you to search a PDF,
HTML, EPUB, and MOBI files if you are reading them on a computer.

o If using an eBook app to read this textbook, the app should have a built-in search
tool.
» Navigate the textbook.

o This textbook has a table of contents to help you navigate through the book easier.
If using the online webbook, you can find the full table of contents on the book’s
homepage or by selecting “Contents” from the top menu when you are in a chapter.

+ Annotate the textbook.

o If you like to highlight or write on your textbooks, you can do that by getting a
print copy, using the Digital PDF in Adobe Reader, or using the highlighting tools

in eReader apps.
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Preface

If you are looking for a quick study guide in Computer Studies, Key Concepts of Computer Studies is
an excellent resource. Skip the lengthy and distracting books and instead use this book to guide your
studies, reviewing, or tutoring. This book quickly gets to the heart of each particular topic, helping
students with a quick review before doing homework. It also supports preparation for tests.

This book was designed for fundamental and intermediate levels in computer studies. It is concise,
understandable, and effective.

Key Features

As an aid to readers, the book provides some noteworthy features:

Key terms, definitions, phrases, concepts, etc. are easily located.
Clear step-by-step instructions.

Clear and easy-to-understand written format and style. Materials presented in visual and gray
scale format.

Self-tests at the end of each unit test students’ understanding of the material. Students can
take the self-test before beginning the unit to determine how much they know about the topic.
Those who do well may decide to move on to the next unit.

Suitable Readers

This book can be used by:

Adult Basic Education (ABE) programs at colleges.

Students at community colleges or high schools.

Self-study readers.

Professionals as a quick review of some basic computer skills.

Anyone else with an interest in the topic.
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SECTION | - FUNDAMENTAL COMPUTER STUDIES

Section I covers the following topics:

 Unit 1. Basic knowledge and common uses of computers
* Unit 2. Keyboarding

» Unit 3. Basic file management and word processing

» Unit 4. Using web search engines
» Unit 5. Electronic communication







Unit 1. Basic knowledge and common uses of
computers

Topic A: Basic knowledge of computers

* System unit
* Basic parts of a computer system

* Hard drive, USB drive, and printer

Topic B: Start a computer system or program

+ Start and shut down a computer system
 Start a program

* Close a program

Topic C: Online communication

* Email and video conferencing
* Social networking

Topic D: Common uses of computers in society

» Computers at home
» Computers in education and business

+ Computers in healthcare and science/engineering

Unit 1 Self-test

Media Attributions

* HP HQ-Tre Core i5 Laptop © Jeanvdmeulen on Pixabay
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Topic A: Basic knowledge of computers

System Unit

System unit — the main part of a desktop computer (the case) that contains all of — I
the main electronic components of a computer. ‘ \

* Other common names of the system unit: tower, chassis, or main unit.

* A system unit includes the motherboard, CPU (Central Processing
Unit), RAM (Random-Access Memory), hard drive, expansion cards,
power supply, etc.

* A system unit does not include peripheral devices, such as keyboard, mouse, monitor, printer,
etc.

* The term system unit is used to distinguish between the computer and its peripheral devices
(keyboard, mouse, monitor, printer, scanner, etc.).

Motherboard (mainboard) — the main circuit board of the computer.

* The motherboard is the system core of a computer.

* The motherboard is a computer’s central structure that
connects the different parts of a computer together.

* Whole computer system is connected, managed, and
controlled by the motherboard.

CPU (Central Processing Unit) — CPU is often referred to as the
brain or engine of a computer where most of the processing and
operations take place.

* Other common names of the CPU: main processor, central
processor, etc.

» The CPU is the primary component of a computer that executes, interprets, and carries out all
instructions.
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RAM (Random-Access Memory) — a type of data storage (memory
element) used in computers that temporarily stores programs and data.

* RAM only holds onto data and programs while the computer
is on.

» All information that was stored in RAM is erased when the
computer is turned off.

Basic Parts of a Computer System

A computer system includes a system unit along with all its software (such as Office 2016, Windows
10, etc.) and peripheral devices (such as a mouse, keyboard, monitor, printer, etc.) connected to it.

Computer monitor — a display screen used to display information (text, image, video, etc.) processed
by a computer.

Keyboard — an input device (the set of typewriter-like keys) that allows a user to enter characters
(letters, numbers, symbols, etc.) into a computer.
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Mouse — a hand-held pointing device that can control the position of a cursor (pointer) on a display
screen.

/\/\)U

Trackpad (or touchpad) — a small flat surface on a laptop or other computer that does the same things
as a mouse (a trackpad is a built-in mouse).

Lo

Hard Drive, USB Drive, and Printer

Hard disk drive (HDD) — the main data storage device in a computer.

¢ Other common names for a hard disk drive: hard disk, hard
drive, fixed disk, etc.

A hard disk drive is a spindle of a set of stacked magnetic
disks (platters) that records and stores information (like
phonograph records).

* When you install programs or save data on hard disk of your
computer, the information is written to the hard disk.

» Hard drives can be internal or external.

USB drive — a small portable storage device used to store or transfer data for computers. It is often
used for storage, data backup, and transfer of computer files.
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» USB stands for Universal Serial Bus.

* Other common names for a USB drive: flash drive, USB
stick, pen drive, thumb drive, etc.

Printer — an output device linked to a computer. It transfers the
information (text, images, etc.) to paper.

Media Attributions

Keyboard computer © 27707 is licensed under a Public Domain license

Mouse computer hardware input © OpenClipart-Vectors is licensed under a Public Domain license
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Topic B: Start a computer system or program

Start and Shut Down a Computer System

Start a computer system

1. Press the computer’s Power button. @
If the monitor is not turned on, press the Power button on the monitor.

2. When the computer has finished booting, it will show a dialogue box that will ask for a
username and password.

3. Enter your username and password, then click “— ” (the submit button) or press the Enter
key on keyboard.

Shut down a computer system (Windows 10)

Method 1

Sleep

Shut down

1. Click the Start icon (at the bottom left corner).

2. Click the Power icon on the main menu. @
3. Click Shut down.

Method 2

us
L
1. Right-click the Start icon.

2. Click or hover over Shut down or sign out.
3. Click Shut down.

Log off (or sign out) a computer (Windows 10):

Method 1

1. Press Ctrl-Alt-Del keys at the same time.
2. Click Sign out.
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Method 2

mn
1]
1. Click the Start icon.

2. Click the User profile icon.  fw
3. Click Sign out.

Method 3

s
am
1. Right-click the Start icon.

2. Click or hover over Shut down or sign out.

3. Click Sign out. (Or click Restart to reboot the computer.)

Start a Program
Start a program or application such as Word, PowerPoint, Paint, etc. (Windows 10)

Method 1

1. Click the Start icon.
2. Click the name of the program that you wish to start (e.g. Word, PowerPoint, etc.).

FEFRE

1. Type the program name in the Search box.

Method 2

2. Click the name of the program that you wish to start.



Method 3

Web

All Apps Documents

Best match
m Word
App

Apps

©  WordPad »
W Office >
Search work and web

L Word - See work and web results >

Documents - This PC (3+)

Documents - SharePoint (2+)

£ Word

Topic B: Start a computer system or program | 11

1. Double-click a program shortcut icon on the desktop. (If the program icon is on the desktop.)

Recycle Bin

oD

Google
Chrome

Method 4

ol'

Snip &
Sketch

ol

]
Outlook

1. Click an open program on the taskbar (the bottom edge of the screen).

ENG 9:00 AM

Us 5/31/2019

Close a Program

Close (exit) a program (close an active open window)

Method 1

1. Click the Close icon (x) in the upper-right corner of the window.
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All Microsoft

2
| a0
PR B

Method 2

1. Click the File, and then click Close.

NN Insert Draw Design Layout | References Mailings Review View Help Acrobat QTeII me |& [

. ‘_". v | €= - A‘;‘ o) [[E ég_m

- R Calibri (Body) 111 ~
U] B J U-aex, X 4

i
4

3

Paste | = Nl EA Styles Editing Create and Share Request
- ¥ A-Y-A-Aa- A A - 2l 0 - z Adobe PDF  Signatures
Clipboard =~ Font ~ Paragraph & Styles = Adobe Acrobat ~

Open @ Recent

Save

[ ] .
Save As a& Shared with Me
Save as Adobe
PDF

OneDrive

Print
Share Personal
et N OneDrive - Personal

Close

Other locations

Method 3

On your keyboard, press Alt + F4 at the same time.
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(Always save your document before closing.)

Media Attributions

* Shut Down or Sign Out © Microsoft. Used with permission.
* Microsoft Office 2013 logos Used with permission from Microsoft

» Microsoft Word Toolbar © Microsoft. Used with permission.
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Topic C: Online communication

Email and Video Conferencing

Online communication refers to the sharing of information or communication over a computer
network (the Internet).

Some popular types of online communication:

il amaysim T 2:36 PM

* Email (electronic mail) — an Internet service that allows users who

have an email account (or address) to send and receive messages B
anywhere in the world. Cmsi
sMall
> An email may contain attachments (files, photos, etc.).
YaHooO!
o Some free email accounts and service providers: Gmail, AOL Aol
Mail, Outlook, Zoho Mail, Yahoo Mail, ProtonMail, Yandex '
Mail, GMX Mail, etc. =4 Hotmail.
* Video conferencing — a live video-based meeting between two or more Other

users in different locations conducted by transmitting audio and video
data in real time.

o Some popular video conferencing services: Skype, Zoom, Lifesize, BlueJeans,
UberConference, Adobe Connect, etc.

Social Networking

* Social networking — the use of websites and other Internet services to communicate with
other people (talk, make new friends, share information, ideas and interests).

o Some popular social media websites: Facebook, WeChat, Skype, YouTube,

15
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Twitter, LinkedIn, Snapchat, Tumblr, Pinterest, TikTok, Instagram, etc.

+ Blog (weblog) — a personal website or webpage that is like an online diary/journal. Blogs are
written and updated by bloggers (they write about their opinions and thoughts).

.

* VoIP (Voice over Internet Protocol) — a telephone connection over the Internet. It allows
users to make calls over the Internet.

o Some popular VoIP: Skype for Business, RingCentral, 8x8, Dialpad, Jive, etc.

* Chat room — an online service that allows people to communicate by typing messages to
each other in real time.

o Some popular chatting sites: Zobe, Badoo, Tiny Chat, Imvu, Chat Avenue, Second
life, ChatIb, MocoSpace, FaceFlow, Chat Random, Moco Space, etc.

Media Attributions

* Email © Mike Seyfang is licensed under a CC BY (Attribution) license
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Topic D: Common uses of computers in society

Computers at Home
There are many things that a computer can do at home, such as:

Manage home budget

 Personal finance software can help you create budget, track
debt, track spending and savings, reduce or eliminate
expenses, plan tax, plan for emergencies, determine short
and long-term financial goals, or even just get a better
handle on your monthly household spending.

» Some personal finance software: Personal Capital, Quicken,
Buxfer, Moneydance, AceMoney Lite, Buddi, GnuCash, etc.

Work from home

* Some work from home jobs: data entry, web developer,
freelance writer, travel agent, call centre representative,
online teaching job, software engineer, social media
manager, translator, accountant, bookkeeper, etc.

Online banking

* Online banking is a banking transaction system that allows
the bank customers to handle account management and
conduct a range of financial transactions via the Internet,
rather than visiting a branch.

* Online banking allows users to make bill payments, view
account details, open a new account, money transfers, pre-
authorized payments, e-transfer, apply for loans, etc.

17
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Entertainment
« Computers are used in a variety of areas for entertainment
purposes, such as videos, movies, television, music, photo

editing, and art (for example, paintings, pictures, poetry,
etc., are just a click away).

Computer games

* Some intelligence games are specially developed to
improve a user’s cognitive abilities and boost thinking power and mental capability.

Computers in Education and Business

Computers in education

The uses of computers in education are plentiful, such as:

 Distance education
* Online courses, programs, and degrees

* Online training resources

* eLearning

» Computer aided teaching and learning. This includes research, school work, storage of
information, quick data processing, audio-visual aids in teaching, better presentation of
information (PowerPoint, Moodle, smart-boards, etc.), entering and viewing grades online,
quick communication between students and instructors, etc.

Computers in business

Computer can help a business start, run, manage, and grow. Computers
can be used in business for:

* Marketing and advertising

 Storage, archiving, and order fulfillment

* Budgeting and forecasting
+ Customer relationship management
* e-commerce

* And more
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Without a computer, it can be very difficult to start, run, and grow the business.

Computers in Healthcare and Science/Engineering

Computers in healthcare

Computers play a crucial role in the healthcare field, such as: P l r g N
« Storing medical and patient data ~me ===

o =
S

* Medical imaging and equipment. This includes X-rays, CT %
scans, MRI scans (Magnetic Resonance Imaging—it can L _a‘

produce a detailed body image), etc.

* Managing appointments with doctors

* Patient monitoring
» Computer-controlled surgeries

+ Diagnostic databases (create a database of a patient records with their treatment and medicine
records)

* Medical research

* Blood testing (take blood samples and analyze the results with computer)

Computers in science/engineering

Computers play a critical role in science/engineering because today is a world of computers.

* Research

* Design (prototype)

* Modelling

» Simulate experiments

* Record, organize, and analysis data

* Report/communication

Media Attributions

Home Office © Free-Photos is licensed under a Public Domain license
Online Banking © rawpixel is licensed under a Public Domain license
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» Computers in Science and Technology © pxhere is licensed under a CCO (Creative Commons Zero) license
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Unit 1: Self-test

Find answers to this self-test at the back of the book: Answers for Self-Tests

True or false

1. A system unit includes the motherboard, CPU, RAM, hard drive, expansion cards, power
supply, etc.

2. A hard drive a computer’s central structure that connects the different parts of a computer
together.

All information that was stored in RAM is erased when the computer is turned on.
A keyboard is an output device that allows a user to enter characters into a computer.

Blogs are written and updated by bloggers. They write about their opinions and thoughts.

o kAW

Computer can help business to start, run, manage, and grow.

Fill in the blank

7. The [blank] is the main part of a desktop computer.

8. CPU is the abbreviation for [blank].

9. RAM is a type of data storage used in computers that [blank] stores programs and data.
10. Computer [blank] is a display screen used to display information processed by a computer.
11. USB stands for [blank].

12. When you save data or install programs on your computer, the information is written to the
[blank] disk.

13. [Blank] is a telephone connection over the Internet. It allows users to make calls over the
Internet.

14. Disk drive is a hardware that stores and retrieves information, data, files, programs, etc. that
are used by your computer. The drive is often referred to by the [blank].
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Multiple choice

15. The [blank] is often referred to as the brain or engine of a computer.
a. CPU
b. motherboard
c. RAM
d. system unit
16. Which of the following is one of the common names used for CPU?
a. processor
b. central processor
C. microprocessor
d. all of the above
17. Which of the following is one of the common names used for USB drive?
a. flash drive
b. pen drive
c. USB stick
d. all of the above

18. A [blank] is a small flat surface on a laptop or other computer that does the same things as a
mouse.

a. flash drive
b. trackpad
c. USB stick
d. RAM
19. Popular social media websites:
a. Facebook
b. WeChat
c. LinkedIn
d. all of the above
20. Computers play a crucial role in science/engineering, such as:
a. simulating experiments
b. patient monitoring
c. diagnostic databases

d. all of the above



Unit 2. Keyboarding

Topic A: Keyboarding skills

+ Touch typing
» Keyboarding technique

Topic B: The base position

* The home row
» Touch typing rules
» Typing speed

Unit 2 Self-test

Media Attributions

« la5 tortuga ninja “SAMMY” © Jorge is licensed under a CC BY (Attribution) license
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Topic A: Keyboarding skills

Touch Typing

Keyboarding skills — the ability to input information at a keyboard smoothly while typing.
Touch typing — a method of typing (with all the available fingers) without looking at the keyboard.
» Touch typing can increase typing accuracy and speed.

 Touch typing includes understanding keyboard layout and its functions.

Benefits of touch typing

Speed (efficient): type faster Hands typing at a computer

* Accuracy (focus): make fewer mistakes keyboard.

* Productivity: type longer without getting tired

Health: less likely have health problems (hands, wrists, neck, etc.)

Typing tips

* Maintain a healthy posture.

+ Familiarize yourself with the keyboard layout.

« Start typing with touch typing.

* Press each key with the proper finger.

» Each key has to pressed by the same finger all the time.
+ Take a typing speed test to keep track of your progress.

Keyboarding Technique

Proper posture

* Body: centre body in front of keyboard and sit up straight.

* Arm position: arms relaxed and bent to about 90 degrees;
elbows naturally close to body.

25
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The mouse and keyboard should be set to the height of elbow height.

» Hand position: hands should be flat, but palms of hands not resting on the keyboard. Keep
wrists off the keyboard.

 Feet position: feet should be flat on the ground, slightly apart (don’t cross).

* Eyes: keep eyes on the screen rather than the keyboard or =
hands. '

Media Attributions

»  Woman using computer © Brian Kerrigan is licensed under a CC BY-SA (Attribution ShareAlike) license



https://commons.wikimedia.org/wiki/File:Woman_using_computer.jpg
https://creativecommons.org/licenses/by-sa/4.0/

Topic B: The base position

The Home Row

The home row is the set of keys that are the base position for fingers. These are the keys located on the
middle row of the keyboard.

a

PrtS Si H F
j .j.. E ‘ﬁﬁ
* ( ) 4 [Backspace Insert Home agE _7 * -
Lock
8 9 0

*T'a‘b F PP i = f”" - RN
= L |1 |
= P FEPTIFPIPP Ll :

; , L0 L
[EhlE Z X c v |8 N M 1 [shift 3 Enter
L /|8 t
“ ) “ ) =) '

“— &L —
Ins Del

The home row keys on the keyboard are A, S, D, and F on the left and J, K, L, and the semicolon (;) on the

right.
D
SYF J Ki

[Image Description]

» Always try to return your fingers to the base position when you are not typing.

» Keyboards usually have small bumps on the F and J keys. They help the users locate the base
position without having to look.

+ Place the index fingers over the “F” and “J” key.

27
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Finger names

Middle finger
Index fingtﬂ' _Ring finger

- Little finger

(pinky)
Thumb
N

Touch Typing Rules

Colour-coded chart

» Always position your fingers properly on the keyboard to press the right keys when typing.

* The colour-coded chart below shows which finger should press each key.

F10 | F11 Fi2

+ Jsackspace

%

hift
i

Ctrl

Labelled keyboard. [Image Description]
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Correct finger placement

* Press all Section A keys with the left little finger
 Press all Section B keys with the left ring finger

* Press all Section C keys with the left middle finger

* Press all Section D keys with the left index finger

* Press all Section E with either thumb

* Press all Section F keys with the right index finger

* Press all Section G keys with the right middle finger
* Press all Section H keys with the right ring finger

* Press all Section I with the right little finger

Typing Speed

Ways to improve typing speed

 Familiarizing yourself with the keyboard layout can improve your typing speed.
» Develop good typing habits; focus on hitting the right keys.

+ Take your time when you have just started learning; slow down to be accurate.
 Learn to be accurate first, then improve speed.

» Not only practice often, but practice correctly.

» Speed will come naturally through practice, repetition, and time.
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Take online typing tests

» Some online typing speed test tools can determine how many words per minute (wpm) you
type and how accurate your typing is.

» There are many free typing tests available online, such as:
o TestMyTypingSpeed
o 10fastfingers

o Key Hero
o The Typing Cat

Image Descriptions

Home row image description: the base position keys for the left hand are:
« Little finger: A key
* Ring finger: S key
+ Middle finger: D key
* Index finger: F key

The base position keys for the right hand are:

* Index finger: J key
* Middle finger: K key
* Ring finger: L key

+ Little finger: Semi-colon key

[Return to Home row image]

Labelled keyboard image description: a standard keyboard with the keys grouped into sections
labelled A to I from left to right. Each section corresponds to a finger that would press the keys in that
section.

+ Section A keys are pressed by the left little finger. The keys include the back quote, Tab,
Caps Locks, Shift, Control, the number 1, letters Q, A, and Z, and Alt.

 Section B keys are pressed by the left ring finger. The keys include the number 2 and letters
W, S, and X.

+ Section C keys are pressed by the left middle finger. The keys include the number 3 and and
letters E, D, and C.

+ Section D keys are pressed by the left index finger. The keys include numbers 4 and 5, and
letters R, T, F, G, V, and B.


https://testmytypingspeed.in/
https://10fastfingers.com/typing-test/english
https://www.keyhero.com/free-typing-test/
http://thetypingcat.com/typing-speed-test/1m
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Section E key is the space bar. The space bar can be pressed by a thumb on either hand.

Section F keys are pressed by the right index finger. These keys include numbers 6 and 7, and
the letters Y, U, H, J, N, and M.

Section G keys are pressed by the right middle finger. These keys include the number 8 and
the letters I and K, and the comma.

Section H keys are pressed by the right ring finger. These keys include the number 9 and the
letters O and L, and the period.

Section I keys are pressed by the right little finger. This includes the rest of the keys on the
right side of the keyboard, including the number 0, the hyphen, the equals sign, the delete
key, the letter P, the open bracket, the close bracket, the backslash, the semicolon, the
apostrophe, the enter key, the forward slash, the shift key, the Alt key, and the Control key.
[Return to Labelled keyboard]







Unit 2: Self-test

Find answers to this self-test at the back of the book: Answers for Self-Tests

True or false

1. Hands should be flat, but palms of hands not resting on the keyboard.
2. Feet should be flat on the ground and cross.

3.
4

. Always try to return your fingers to the base position when you are not typing.

Keep eyes on the hands rather than the keyboard.

Fill in the blank

[Blank] typing is a method of typing without looking at the keyboard.
[Blank] body in front of keyboard and sit up straight.

Base positions or [blank] row keys: the row of keys located on the middle row of the
keyboard.

The home row keys for the left hand are A, S, [blank], and F.
The home row keys for the right hand are J, [blank], L, and the semicolon (;).

Multiple choice

10.

11.

Benefits of touch typing:
a. speed
b. productivity
c. accuracy
d. all of the above

Arms relaxed and bent to about [blank] degrees; elbows naturally close to body.
a. 45°
b. 60°
c. 30°
d. 90°
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12. The home row keys for the left hand are A, S, D, and [blank].
a. L
b. F
c. K
d. L
13. Keyboards usually have small bumps on the [blank] keys.
a. Sand D
b. Aand F
c. FandJ
d. all of the above
14. Press all [blank] keys with the left ring finger.
a. pink
b. brown
c. yellow
d. purple
15. Press all [blank] keys with the left index finger.
a. pink
b. brown
c. light green
d. purple
16. Press all [blank] keys with the right ring finger.
a. grey
b. brown

c. light green

L

purple



Unit 3. Basic file management and word processing

Topic A: Types of computer drives and pointing actions

» Types of computer drives

* Pointing actions

Topic B: Basic file management

» Folder and file
» Ribbon
* Basic file management skills

* Operate a printer

Topic C: Basic word processing

* Create a document
» Check spelling and grammar

 Find synonyms

Unit 3 Self-test
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Topic A: Types of computer drives and pointing actions

Types of Computer Drives

Disk drive (drive) — a computer device that stores and retrieves information, data, files, programs, etc.,
from a disk. The drive is often referred to by its letter (your drive letter may differ).

* A hard disk drive (hard disk or fixed disk) is usually designated as the “C: drive”. The hard
disk drive is the main data storage hardware device in a computer that can provide quick
access to large amounts of data. Find more information about computer hardware.

* A network drive is usually designated as the “U: drive”.

y| 2
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» A removable disk (USB) is usually designated as the “H: drive” or “K: drive”.
o A USB flash drive is a small portable external device used for data storage.

o The most common use for external drives (USB) is for backup purposes or to
transfer files from one computer to another.

Pointing Actions

Pointing device — a device used to control the movement of the pointer (cursor) on the screen.
The major pointing devices in use today are the:

* mouse (desktop computer)

* touchpad (laptop)

A

* touch screen

(I
Y d

Basic pointing actions (use a mouse or trackpad/touchpad)

* Point and click — point an object on the screen and then press the left button on the mouse
(or tap on the trackpad) to select items/commands, open menus/hyperlinks (links), or close
windows.
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* Double-click — quickly click the left mouse button twice (or double tap on the trackpad) on
any folder, file, or program to open it.

* Drag and drop — press and hold the left mouse button to grab an item (or double tap on the
trackpad) and place it to a different location.

Example: drag the selected text to the new location.

* Right-click — press the right mouse button (or tap two fingers anywhere
on the trackpad) to display a popup menu showing commands for a
selected item.

Media Attributions

» Hard Disk © Denilson Novaes is licensed under a CC BY (Attribution) license

* DVD Writer © yum9me is licensed under a CC BY-NC-ND (Attribution NonCommercial NoDerivatives) license
» DSCF0597 © robin strain is licensed under a CC BY-NC (Attribution NonCommercial) license

+ USB Memory Drive © TheDigitalArtist is licensed under a Public Domain license

*  Mouse © OpenClipart-Vectors is licensed under a Public Domain license

» Tablet © niekverlan is licensed under a Public Domain license

» Right click © Niekverlan adapted by Meizhong Wang is licensed under a Public Domain license


https://search.creativecommons.org/photos/97b7412a-a8be-41a7-987b-2897d5d2011f
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https://creativecommons.org/licenses/by-nc/4.0/
https://pixabay.com/illustrations/usb-memory-drive-technology-flash-686359/
https://creativecommons.org/publicdomain/mark/1.0/
https://pixabay.com/vectors/mouse-computer-hardware-optical-159568/
https://creativecommons.org/publicdomain/mark/1.0/
https://pixabay.com/photos/tablet-ipad-read-screen-swipe-1075789/
https://creativecommons.org/publicdomain/mark/1.0/
https://pixabay.com/photos/tablet-ipad-read-screen-swipe-1075789/
https://creativecommons.org/publicdomain/mark/1.0/




Topic B: Basic file management

Folder and File

Folder (or directory) — a virtual storage space used to store and organize computer

files. I—\—

A folder can also contain additional folders (known as subfolders).
1

A folder has a name and is represented by an icon.

File — a storage unit on a computer that stores information, data, etc. (such as a document, an image,
etc.).

» Folders contain files

* Files have names and are represented by various icons

Section 1 - Unit 1
Section 1 - Unit 2
Section 1 - Unit 3
Section 1 - Unit 4

Filename — a unique name given to a file to identify it. A filename can contain letters, symbols,
numbers, spaces, etc.
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Right-click to create a new folder (Windows
10)

1. Go to the location where you want
to create the folder (Desktop,
Documents, or anywhere on your
computer).

2. Right-click on a blank space (don’t
right-click on an existing item in the
folder).

3. Click or hover over New.

Click Folder.

%
L

Type a name for the new folder and
press Enter (on the keyboard).

Ribbon

View
Sort by

Refresh

Share
View online
Manage OneDrive backup

Always keep on this device

New Folder

Display settings Shortcut

Personalize i Microsoft Access Database
Bitmap image

§  Microsoft Word Document
Microsoft Access Database

i Microsoft PowerPoint Presentation

B Microsoft Publisher Document
Rich Text Format
Text Document

§  Microsoft Excel Worksheet

fl Compressed (zipped) Folder

Ribbon — a group of buttons and icons (tabs) at the top of the window that allows users to access the

commands that they need to complete a task.

@ = —T—
J.‘?S (12 v A~ A~ A"B'A\?abim =TIz v A= v €= 9= “_q_.' THIR |
Paste B I Ujree X; x2/|A" X -AHB @ |=l= = = 1&$=&r i
Create a new folder from the ribbon menu (Windows 10)
1. Go to the location where you want to create the folder (e.g., Documents).
2. Click Home.
3. Click New folder.
4. Type a name for the new folder and press Enter (on the keyboard).
[ [+ = | Documents
ile Share View
—_‘ x L_._ New item = i—l Open HH select an
opy path i | Easy access ~ Edit Select none
1 to Quick Paste ) pve Delete Rename MNew - Properties _ o _
ACCESS #) Fasie shortout t t - folder - £ History O Invert selection

Clipboard Crganize

MNew Open Select
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Basic File Management Skills

Basic file management refers to a way to name, save, backup, organize files/folders and keep track of
files on a computer.

Some file management tips

+ Create folders/subfolders to organize files.
+ Save your work frequently in folders/subfolders (organize by category).
* Save your files on a backup disk regularly (back up your files).

* Give files and folders short, but meaningful names.

Save afile for the first time or save a file with a different name or location (Microsoft Word)

1. Click the File tab in Microsoft Word.

AutoSave (@ off) (L]

Home Insert Draw

1. Click the Save As command.

Info

Save

Save As

Print

Share

Export

1. Choose a location on your computer (e.g., USB drive or hard disk drive) to save your file.
2. Type a name for your document in the File Name box.

3. Click the Save button.

1~ = Documents

History 112 Essay
Word Document (*.docx) - Fj Save
More options...
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Save an existing file in its current location (Microsoft Word)

1. Click the File tab.
2. Click the Save command.

3. Or click the Save button icon.

AutoSave (@ off) = ®~ =

Operate a Printer

Printer — a device that is usually connected to a computer in order to transfer the text and graphic
information to paper.
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Print

Operate a printer

1. Load paper in the paper tray if needed.

Press the Power button to turn the printer =

on. Print

Open the file you want to print. .
Printer

Click the File tab.

‘% PRMNP2-223-101BW an PPRL..
= Ready

Printer Properties

Settings

The wwhole thing

Print on Both Sides

Click the Print command.

AL S

Select the print options: Number of
Copies, Print All pages, or Pages (e.g.,
from page 2 to page 5), etc.

7. Click Print or Okay to start the printing
process.

Account
Flip pages on long edge

t_:lpthn',

Caollated

Partiait Onentation -

Letter

"
Marmal Margins
Left: 1" Right 1

1 Page Per Sheet -

Media Attributions

* Folder icon © Pettycon is licensed under a Public Domain license
» File © Microsoft. Used with permission


https://creativecommons.org/publicdomain/mark/1.0/
https://www.microsoft.com/en-us/legal/intellectualproperty/permissions/default.aspx




Topic C: Basic word processing

Creating a Document

Word processing — the use of a program (software application) running on a computer to create, edit,
format, and store documents.

Create a new blank document @

New

. Start Word. o Hmme
. Click the File tab.

B New

1
2
3. Click New command.
4

. Click Blank document. A new blank [E=AelE
document appears.

5. Type your document (text Info
you type will be
inserted into the document). Save

Save As

Open an existing document

Blank document

1. Start Word. m Edit View Insert Forn
2. Click the File tab. New Document 8N
3. Click the Open command. New from Template... <3P
4. Choose the location on the computer that stores Open... #0
your file (the drive and folder). Open Recent >
5. Click the name of the file you want to open. Close LW
6. Click Open or double click the file name. Save #S
Save As... {+3€S

. ol
Check Spelling and Grammar Save as Template

Method 1

1. Open an existing document.

2. Right-click a word that is underlined with a wavy line (that indicates a
misspelled word).

3. Select the correct spelling from the suggestion list (to change the spelling

47
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error). For each error, Word will offer one or more suggestions.

Spelling exror Correct spelling
- e
* Open an existing dacument. ... dacument. ...
« Click the Review tab d that is u doctment
o Ignore All
* Click Spelling & Grammar button. . Add to Dictionary

will offer o

Method 2

1. Open an existing document.
2. Click the Review tab.

3. Click the Editor button (it may also be called Spelling & Grammar). If the program finds
spelling errors, the Editor pane will
appear.

File Home Insert Draw Design Layout References Mailings

/ Editor A)) 7, A —lt] L V:I i t?’jmk Con

: 52

Thesaurus Read Check Language New

Z123Word Count Aloud Accessibility ¥ Comment L1 Show Comments
Proofing Speech Accessibility Comments

4. Click one of the options from the suggestion list to change the spelling error.

5. The program will move to the next misspelled word.
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Find Synonyms

Method 1

1. Open an existing document.

2. Right-click a word for which you wish to find a

synonym. FE‘] Paste Options:
3. Click the Synonyms command on the pop-out [A

mend. A Font..

4. Find a desired word in the list and click it to == paragraph.:
replace the original word. Jo

Search "document”

5. If none of the synonyms is desired, click the
Thesaurus command to open the full - . :
. [} Rewrite Suggestions text

thesaurus. (The Thesaurus pane will appear.)

Synonyms > paper

5§ Translate file
6. Find a desired word in the Thesaurus pane list -
@ Link > anicle

and right-click it, or point to a desired
word in the Thesaurus pane gradient and
click the list arrow.

w New Comment certificate

@ Thesaurus...

7. Click Insert [the desired word] on the menu
that opens.
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Thesaurus

O, document Q

¥ text (n.)
file

| artir'

ass

Copy "article”
Insert "article"

pap
manuscript
deed
certificate
record
¥ record (v.)
detail
verify
authenticate
support
keep a record (Dictionary Form)
write down (Dictionary Form)
provide evidence (Dictionary Form)
give proof (Dictionary Form)

Method 2

1.
2.
3.
4.

Open an existing document.

Select a word for which you wish to use the thesaurus.
Click the Review tab.

Click the Thesaurus button.

File Home Insert Draw Design Layout References Mailings Review
/£ Editor ) A T ol Z1ink Comr
{‘i‘,’ lv——l 4
Thesaurus Read Check Language New
=123 Word Count Aloud | Accessibility 5 Comment [J Show Comments
Proofing Speech Accessibility Comments

Find a desired word in the Thesaurus pane and right-click it, or point to a desired word in
the Thesaurus pane list and click the list arrow.

Click Insert [the desired word] on the menu that opens.

Close the Thesaurus pane.



Unit 3: Self-test

Find answers to this self-test at the back of the book: Answers for Self-Tests

True or false

Filename: a unique name given to a file to identify it.
A folder cannot contain additional folders.

Basic file management refers to a way to name, save, backup, organize files/folders and keep
tracking of files on a computer.

Point and click: press and hold the left mouse button to grab an object and place it to a
different location.

Fill in the blank

10.

When you save data or install programs on your computer, the information is written to the
[blank] disk.

A [blank] is a telephone connection over the Internet. It allows users to make calls over the
Internet.

A computer device that stores and retrieves information, data, files, programs, etc. from a
disk. The drive is often referred to by the [blank].

A [blank] is a virtual storage space used to store and organize computer files.

A [blank] is a device that is usually connected to a computer in order to transfer the text and
graphic information to paper.

Word processing is the use of a program running on a computer that allows users to create,
[blank], format, and store documents.

Multiple choice

11.

The [blank] is a group of buttons and icons at the top of the window. It allows users to access
the commands that they need to complete a task.

a. stick
b. tab

c. ribbon
RAM

L
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12. A filename can contain:
a. letters
b. symbols
c. numbers
d. all of the above
13. A folder has a name and is represented by [blank].
a. astick
b. anicon
c. number
d. atab

14. [Blank] is the use of a program running on a computer that allows users to create, edit, format
and store documents.

spreadsheet

a
b. file management

0

word processing

all of the above

d.

Media Attributions

*  Work © jeffbr13 is licensed under a CC BY-SA (Attribution ShareAlike) license
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Unit 4. Using web search engines

Topic A: Web search engines

» Perform a search using a web search engine
* Web browsers and bookmarks
* Google Chrome

* Internet Explorer

Topic B: Search the Internet using a web search engine

+ Fill in online forms
» Use library websites to request books/other resources

» Use library websites to renew books/other resources

Unit 4 Self-test
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Topic A: Web search engines

Perform a Search Using a Web Search Engine

Search engine — a web-based tool that is designed to search the content of web pages and find
particular information on the Internet.

Some popular search engines

* Google bing YaEOO!
o Bi - remege ekc
lng Got)g[e o (;; Ba‘.&ﬁin ROR
e Baidu YaroO! Google
o
* Yahoo! g
* Yandex
» Ask.com

* DuckDuckGo

Search the Internet using a web search engine

1. Open a search engine in a web browser (such as Internet

Explorer).
Google

2. Type a few specific keywords or phrases in the search box
to describe whatever you wish to search. Search engines
look for the keywords in your query.

3. Press Enter. The search engine will display a list of websites (page after page) that include
information related to your query.

4. Repeat above steps (type different keywords or phrases) if necessary.

Web Browsers and Bookmarks

Browsers

» Browser — a software program that allows users to access and display websites or web pages
(documents, images, videos, music, etc.) on the Internet.

Some popular web browsers:
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|

‘.
. Google Chrome

Mozilla Firefox

f )
. @ Internet Explorer

o,

S

Bookmarks

* Bookmark (or favourite): a collection of links (saved iy
shortcuts) to web pages that is stored in a web browser.

77 Favorites
» Saving bookmarks allows users to quickly navigate back == web files access
to the websites they visit the most. 4 CBG Listen | Radio One | Toronto

» Bookmark bar: A toolbar that contains all bookmarks O s

and is displayed at the top of a browser window (under W% Qollege

& H&Eik#E M -- Creaders.NET, BBSLAND.com

the address bar).
File Edit View History Bookmarks Window Help QME O F 14l coadnbngn 41% @) Sun 11
i 9% e &

I Web files access CBC Listen | ...ne | Toronto  Prince George Citizen College JFi4i%#&M -- ...SLAND.com I

Google Chrome

Add bookmarks to Google Chrome

1. Open Chrome by double-clicking. e @ @ 'S P wl @ S.\

2. Go to the website you would like to
bookmark.

3. Click on the star icon * to the upper-right corner to add the bookmark.

O 0 NewTad X +

¢ (6 & &

i Apps @ NewTab @e College of New C...

Gmail Images
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1. Click Done.

*
_ X
Edit bookmark
Name College of New Caledonia | CNC
Folder Bookmarks Bar v

Mom. h Removo m

Find a bookmark in Chrome

Method 1

‘O
1. Open Chrome.

2. Click three dots (More options) in the upper-right corner.

000 NewTd X+

¢ (6 * 2 [:]

H Aops @ NewTab @& College of NewC...

Gmail Images

1. Click Bookmarks (in the pop-up menu that appears). *
2. Find and click a bookmark to open it. New Tab %7
New Window %N
Method 2 New Incognito Window Q%N
History >
Downloads XL
O »
1. Open Chrome. oo S E— T

2. Find and click a bookmark on the bookmarks bar to open
it.

Show or hide the bookmarks bar in Chrome

1. Open Chrome.

2. Click three dots icon to the upper-right corner.
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3. Click Bookmarks.

4. Click Show Bookmarks Bar to turn the bookmarks bar on and off.
(A check mark means the bookmarks bar is showing. No check mark means it’s hidden.)

w

New Tab AT

New Window 8N

New Incognito Window 08N

History >

Downloads 8L

Bookmark This Page... 3D 4

Bookmark Open Pages... 3D Zoom ~ 100% + oo

IJ Show Bookmarks Bar I 0 ¥8B Print... #P
Bookmark Manager X ¥B Cast...

1 Import Bookmarks and Settings... Find... 8F

I @ NewTab More Tools >

anc College of New Caledonia | CNC Edit Cut Copy Paste

Settings 88,

Help >

Internet Explorer

Add bookmarks to Internet Explorer

e

1. Open Internet Explorer double-click on Internet Explorer to open it.
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2. Go to the website you would like to bookmark. e
3. Right-click on an empty space of the page.
4. Select Add to Favorites from the pop-up menu that appears.
5. Click Add. R
Add a Favorite X
a5
All Accelerators >
- Add a Favorite
N Add this webpage as a favorite. To access your favorites, visit the ESSEa
Favorites Center.
View source
Name: ollege of New Caledonia CNC Inspect element
- Encoding >
Createin: |57 Favortes v || New folder oo
—_— Print preview...
| Add | Cancel Refresh
Export to Microsoft Excel
Send to OneNote
You may also click on the star icon * in the upper-right corner to L
add the bookmark.

Find a bookmark in Internet Explorer

1. Open Internet Explorer.

2. Click on the star icon * in the upper-right corner.

3. Find and click a bookmark to open it.

Or use the bookmarks bar that shows under the address bar. Click a bookmark to open it.

e onc https//cncbe.ca/

5.5 e College of New Caledonia.. & Vancouver, British Colum...
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Show or hide the bookmark bar in Internet Explorer

1. Open Internet Explorer.

2. Right-click on the top side (empty space) of the
Window.

3. Click the Favorites bar on the pop-up menu.

Media Attributions

Menu bar

v | Favorites bar

v

v

Command bar

Status bar

Lock the toolbars

Show tabs on a separate row

Restore
Move
Size
Minimize
Maximize

Close Alt+F4

* Google © Google. Google and the Google logo are registered trademarks of Google LLC, used with permission.

* Bookmarks © Apple. Used with permission.

+ Star is licensed under a Public Domain license


https://www.google.com/permissions/products/
https://www.apple.com/ca/legal/intellectual-property/guidelinesfor3rdparties.html
https://commons.wikimedia.org/wiki/File:Star_empty.svg
https://creativecommons.org/publicdomain/mark/1.0/

Topic B: Search the Internet using a web search engine

Fill in Online Forms

Steps to fill in an online form

1.
2.
3.

Save the online form on your computer.
Open the form.

Click on an empty text field in the form to start filling in the form. Carefully fill in the
necessary information. Double check to be sure that there are no mistakes.

Add check marks if any are required.

5. Save the form. When done, you can email, print or fax the filled out form.

PDF (Portable Document Format)

* A PDF is a file format that looks like a printed document. It displays files in a

» A PDF file allows for incorporation of electronic text, images, graphs,

format that is ready for the web.

hyperlinks, etc.

» A PDF file can be viewed, printed, or forwarded to someone else. To view the PDF files, you

need the Acrobat Reader, which is available for free download.
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Steps to fill in a fillable PDF form

1.

Save the PDF form on your
computer.

Open the form in Acrobat Reader.

Click on an empty text field in the
form to start filling in the PDF form.

Save the form. When done, you can

email, print or fax the filled out form.

Use Library Websites to Request
Books/Other Resources

Open a search engine in a web

browser (such as Google in Chrome).

Find the website for a library near
you.

Search the Library Catalogue (type
your specific information into the
search box). Library Catalogue is the

main search box on Library webpages.

We value vour business and would like to receive vour leedback,
Please complete the form below to help us improve our services!

NH TR (thuﬁ:(]murftllmpln}': Y‘.‘a“"\- “'L'L'- L5 I:H.,'{'I'I. hL'I'l'II11_=: _\'tll.I:
'i'rr_x Very
Satished  Sasshied  Newtral Unsatished Unsaished
Timeliness O O O O O
."I.-:,'i,'l.ll'.'ll."'r D D I:l |:| D
Prolessionalism O O O O 0
Friendliness O O O O M
Convenience O O O O O
Cualivy D | U D D
Owerrall services O O O ( Ll

What can we improve on?

Additional commenis:

Click on the title you wish to request (from the results list). Check the availability status.

Click on the Place Hold button in the list of items (to place hold on your book).

Enter your Library card number (or Username or
Barcode for some libraries) and PIN number to Log In.
When you signed up for your library card, you chose a

personal identification number (PIN).

Click on Place Hold(s).

Search methods

search box.

 Searching by title or author: Type keywords from the title or the author’s name into the

 Searching by subject: Type keywords from your topic into the search box.
» Searching by ISBN: Type the ISBN number into the search box.

Use Library Websites to Renew Books/Other Resources

1. Open a search engine in a web browser (such as Google in Chrome).
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. Find the website for a library near you.

3. Click on My Account (or Log In in some libraries).

. Enter your Library card number (or Username or Barcode for some libraries) and PIN
number to Log In.

. Click on Checkouts.

. Click each title that you would like to renew.

. Click on Renew. (Renew option will not be available if another user has requested the book.)






Unit 4: Self-test

Find answers to this self-test at the back of the book: Answers for Self-Tests

True or false

1. A web browser is a collection of links to web pages that is stored in a web browser.

2. Saving bookmarks allows users to quickly navigate back to the websites they visit the most.

3. You can click on the star icon to the upper-right corner (in Chrome) to add a bookmark.

4. Clicking the “Favorites bar” on the pop-up menu cannot show or hide the bookmark bar in
Internet Explorer.

Fill in the blank

5. A [blank] is a software program that allows users to access and display websites or web
pages on the Internet.

6. The bookmark [blank] contains all bookmarks that shows on the top of the window.

7. A [blank] is a file format that looks like a printed document.

Multiple choice

8.

9.

10.

Some common web browsers include:
a. Mozilla Firefox
b. Google Chrome
c. Opera
d. all of the above

An Internet [blank] is a web-based tool that is designed to search the content of web pages
and to find particular information on the Internet.

a. bar
b. RAM
c. search engine

d. all of the above

Some popular search engines include:
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a
b.

/e 0

Baidu
Google
Yandex

all of the above



Unit 5. Electronic communication

Topic A: Security issues on the Internet

* Security issues

 Prevent cyber threats

Topic B: Email

* Email address
» Create an email account
* Sending and receiving email

* Mail system folders

Unit 5 Self-test
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Topic A: Security issues on the Internet

Security Issues

Although Internet led to many benefits, it also poses a greater potential for security threats. Below are a
number of common Internet security issues.

Hacker

Hacker — refers to a person who can gain unauthorized access to (break into) a computer or a network
to commit crimes.

Some things a skilled hacker can do to your computer:

* Hijack your usernames and passwords;

» Gain access to the personal information (credit card numbers, bank account, Social Insurance
Number, etc.);

* Steal, change, exploit, sell, or destroy data;
» Damage or bring down the system;

» Hold the system hostage to collect ransom;

Malware

Malware (short for malicious software) — a software that is designed to damage, disrupt, or infect
computers.

» Malware is a single term that refers to all the different types of threats to your computer
safety such as virus, Trojan horse, worm, spyware, etc.

* Malware can gain unauthorized access to a computer and continuously run in the background
without the owner’s knowledge.

Computer virus

Computer virus — a specific type of malware that is designed to replicate (copy) and spread from one
computer to another.

A virus can make a copy of itself over and over again.

A virus can spread from one computer to another through email attachments, removable
storage devices, networks (Internet messaging services, download infected files ...), etc.
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* A virus can damage your computer by corrupting system files, sending spam, stealing data
and personal information from your computer, destroying data, deleting everything on your
hard drive, etc.

Trojan horse

Trojan horse (or Trojan) — a type of malware that looks harmless but can cause harm to a computer
system.
» A Trojan misleads users of its true intent.

* A Trojan may claim to get rid of your computer viruses but instead introduce viruses onto
your computer.

* A Trojan can take the form of innocent-looking email attachments, downloads, etc.

Worm

Worm — it is similar to a virus (a sub-class of a virus). It is designed to quickly self-replicate and
spread copies of itself from one computer to another.

+ The key difference between a worm and a virus is that a worm does not require any human
action to replicate while a virus does. A virus only spreads when a user opens an affected file
whereas a worm spreads without the use of a host file.

Phishing

Phishing — a scammer uses deceptive emails or websites and tries to obtain valuable personal
information (i.e., username, password, account number, etc.).
* Phishing is a common online scam used by cyber criminals.

* A scammer may use a deceptive email or website appearing to represent a legitimate firm.

Spyware

Spyware — a software that secretly monitors (spies) user’s online behaviour and gets sensitive
information about a person or organization without the user’s knowledge.

» A spyware can record a user’s Web browsing habits, email messages, keystrokes on online
advertisements, personal information, etc., and forward it to a third party.
» Advertisers can use spyware to target specific advertisements to your tastes.

+ Criminal organizations can use spyware to collect financial information (banking accounts,
credit card information, password, etc.).
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Prevent Cyber Threats

Tips on how to prevent malware from infecting your computer

+ Backup files and store in different locations.
* Don’t open any suspicious/unknown emails or the websites.

* The second part (the part after the @) of an email should represent the company that owns
the email (domain).

Example: registrarsoffice@cnc.bc.ca

(cnc.bc.ca is the domain for the College of New Caledonia)

* Don’t download an unknown or suspicious attachment (document, picture, music, game,
video, etc.).

* Do not call fake tech support numbers (tech support scams).

« If you get pop-up window from fake companies offering to help you with a malware
infection, don’t call the number.

» Use a secure and strong password (unique, hard to guess, etc.).
* Install anti-malware/virus software (keep it up to date).

 Scan with antivirus software on a regular basis.

Some free antivirus software

» Comodo Antivirus
¢ AVAST Free Antivirus
¢ AVG Antivirus Free

e ¥

: .
o ovast! \
be free

¢ Avira Antivirus
» Bitdefender Antivirus
* Sophos Home Free

+ Kaspersky Free






Topic B: Email

Email Address

An email address consists of three parts:

+ Username of the recipient.
* (@ sign (pronounced “at” sign) — every email address consists of an @ sign.

* Domain (the email service provider — an organization/company, or a website name).

a) reginfo@sfu.ca

Username Domain (SFU)

b) username(@gmail.com

Domain (website name)

Example Emails

Some popular free email service providers include

* Gmail (username@gmail.com)

* Outlook (username@outlook.com)

* Yahoo! Mail (username@yahoo.com)

* ProtonMail (username@protonmail.com)
* Zoho (username@zoho.com)

* AOL (username@aol.com)

Create an Email Account

This is how you can create a Gmail account.

1. On your computer, open a browser window and go to Gmail.
® ™ https://www.google.com/gmail/about/#
2. Click Create an account (top right of screen).
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For Work Sign in Create an account

3. Enter your first name, late name, username, and password (twice). Click Next.
Create your Google Account

to continue to Gmail

First name Last name

Username @gmail.com

You can use letters, numbers & periods

Password Confirm @

Use 8 or more characters with a mix of letters, numbers &
symbols

Sign in instead

4. Provide the additional information, including your birthday and gender. Click Next.

i+l v

[ Phone number (optional)

We'll use your number for account security. It won't be visible to
others.

Recovery email address (optional)

We'll use it to keep your account secure
Month v Day Year
Your birthday

Gender v

Why we ask for this information
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Privacy and Terms

Combining data

We also combine this data among our services and across
your devices for these purposes. For example, depending
on your account settings, we show you ads based on
information about your interests, which we can derive from
your use of Search and YouTube, and we use data from
trillions of search queries to build spell-correction models
that we use across all of our services.

You're in control

Depending on your account settings, some of this data
may be associated with your Google Account and we treat
this data as personal information. You can control how we
collect and use this data now by clicking “More Options”
below. You can always adjust your controls later or
withdraw your consent for the future by visiting My
Account (myaccount.google.com).

MORE OPTIONS w

Cancel | agree

Your account will be created and ready to send and receive emails.

5. Scroll down and click I agree.

Send and Receive Email

How to send an email

1. Log into your personal email account (such as Gmail, Outlook, Yahoo! Mail, etc.) or log into
your institutional email (many colleges and universities give students an email address).

2. Click Compose (if using Gmail) or something similar. (For example, in Outlook, click New.)

= M Gmail Q_ Search mail
o- ¢
'— Compose
[J Primary % Social @ Promotions

J Inbox 17

3. Enter a recipient’s email address in the To field. You can also add recipients in the Cc and
Bcc fields.

4. Enter a subject (the topic or heading of your email).

5. Type your message in the main body field.
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6. Click Send.

New Message =X
\ To | Cc Bee

Subject

Y Hi,

']

CcandBcc

* Cc (carbon or courtesy copy) — Entering a person’s email address in the “Cc” field means that
person will receive a copy of the email (for their information).

* Bcc (blind carbon copy) — Bcc is similar to that of Cc except that the email address is
invisible to the people in the “To” or “Cc” fields. Use Bcc if you don’t want the other people
to see who else has received a copy of the email.

Send Emails with Attachments

You can attach different types of files to send through email, including PDFs, images, and more. This is
how you attach a file to an email:

Log in to your email account.

Click Compose (Gmail) or something similar (e.g., New in Outlook).

Enter a recipient’s email address in the To field.

Enter a subject.

Type your message in the main body field.

o Uk w b=

Click Attach or something similar. (Note that the Attach option is often represented as a
paperclip icon).

E:iccomo @
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7. Select the file you want to attach from your computer’s folder.
8. Click the Choose or Select button (or another similar button) to attach the file to your email.
9. Click Send.

i Send Attach || Discard  eee
i t

To Bcc

Cc

Mail System Folders

+ Inbox folder — the place where incoming emails are received and stored (incoming emails
arrive in “Inbox” folder).

+ Sent Items (or Sent) folder — the email you’ve sent will be saved in the “Sent Items” (or
“Sent Mail”) folder.

* Drafts folder — an unfinished email will be automatically saved to your “Drafts” folder.

* Deleted Items folder: every email that you deleted will be moved to the “Deleted Items”
folder.

o It’s a good idea to empty your “Deleted Items” folder from time to time in order to
save space.

o To empty the Deleted Items folder: Right-click the Deleted Items folder and click
Empty folder, then Ok.






Unit 5: Self-test

Find answers to this self-test at the back of the book: Answers for Self-Tests

True or false

A malware cannot gain unauthorized access to a computer and continuously run in the
background without owner’s knowledge.

A virus can make a copy of itself over and over again.

A Trojan may claim to get rid your computer of viruses but instead introduces viruses onto
your computer.

The key difference between a virus and a worm is that a worm needs human action to
replicate, whereas, a virus doesn’t.

Enter a person’s email address to the ‘Cc’ field means that person will receive a copy of the
email.

Fill in the blank

10.

11.
12.

A [blank] refers to a person who can gain unauthorized access to a computer or a network to
commit crimes.

A [blank] can spread from one computer to another through email attachments, removable
storage devices, networks, etc.

A [blank] is similar to a virus. It is designed to quickly self-replicate and spread copies of
themselves from one computer to another.

A [blank] can record a user’s Web browsing habits, email messages, keystrokes on online
advertisements, personal information, etc., and forward it to a third party.

Bcc is similar to that of Cc except that the email addresses are [blank] to the people in the
“To” or “Cc” fields.

The [blank] folder is the place where incoming emails are received and stored.

Every email that you delete will be moved to the “[blank] Items” folder.
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Multiple choice

13. [Blank] is a software that is designed to infiltrate, damage, disrupt, or infect computers.

a. Malware
b. Firefox
c. Yandex

d. RAM

14. Malware is a single term that refers to all the different types of threats to your computer

safety such as:
a. Trojan horse
b. worm
c. virus

d. all of the above

15. [Blank] is a software that secretly monitors (spies) user’s online behaviour and gets sensitive

information about a person or organization without the user’s knowledge.

a. Trojan horse
b. spyware
c. virus
d. worm

16. An unfinished email will be automatically saved to your [blank] folder.
a. Sent
b. Junk
c. Drafts

d.

Deleted items




SECTION Il - INTERMEDIATE COMPUTER STUDIES

Section II covers the following topics:

» Unit 6. Basic computer terminologies

» Unit 7. Evolution of computers

¢ Unit 8. Operating system

» Unit 9. Basic word processing skills

» Unit 10. More on word processing

» Unit 11. More on electronic communication
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Unit 6. Basic computer terminologies

Topic A: Application programs

» Word processor and spreadsheet
 Presentation and database programs

* Launch and terminate a program

Topic B: Types of computers

* Super computers and mainframe computers
* Minicomputers and personal computers

» Types of personal computers

Topic C: Basic computer terminologies and acronyms

* Basic Internet terminologies
 Basic computer terminologies

* Bits and bytes

Unit 6 Self-test
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Topic A: Application programs

Word Processors and Spreadsheets

Application program — a computer program that provides users with tools to accomplish a specific
task.

Examples of application programs include those for word processing, spreadsheets, presentations, and
database management, as well as Internet browsers, email programs, media players, accounting
software, and programs that help with pronunciation, translation, desktop publishing, enterprise.

Microsoft Office — A group of productivity software applications developed by Microsoft Corporation.
Microsoft Office 2016 includes such programs as Microsoft Word, Microsoft Excel, and Microsoft
PowerPoint.

Word processors

Word processor — a program that allows users to create, save, edit, format, print, and retrieve
documents.

Word processing programs can be used to create all types of text-based documents, such as:

» Assignments

* Notes

* Memos

* Letters

* Resumes

* Articles

* Reports

* Newsletters

 Short stories

* Books (with tables, diagrams, photos, links, etc.)

Examples of word processing programs include Microsoft Word, Google Docs, Apple Pages, and
LibreOffice Writer.
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[First Name]
[Surname]

Experience

[Dates From]-[To]
[Job Title]e [Job Position] ® [Company Name]

[Dates From]-[To]
[Job Title]e [Job Position] ® [Company Name]

[Dates From]-[To]
[Job Title]e [Job Position] ® [Company Name]

[Yf’ur Address] [This is the place for a brief summary of your key responsibilities and
[City, ST ZIP Code] most stellar accomplishments.]

[Your Phone] Education

[School Name], [City, State]
[Your Email] e [You might want to include your GPA here and a brief summary of
relevant coursework, awards, and honors.]

[Your Website] Communication

[Want to put your own image in the circle? Itis easy! Select the image

Spreadsheets

Spreadsheet (electronic worksheet) — a program that organizes data into rows and columns, also
known as tabular form. This data can then be arranged, sorted, calculated (using formulas and
functions), analyzed, or illustrated using graphical representations.

Among many other things, a spreadsheet program can be used to:

 Create budgets

 Calculate grades

+ Balance bank accounts

 Calculate loan payments

+ Calculate tax

* Prepare payrolls

* Analyze business performance numbers and results
* Produce charts

» (Calculate revenues
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Examples of spreadsheet programs include Microsoft Excel, Google Sheets, Apple Numbers, and

LibreOffice Calc.
Page | (Edit || rormat | _Publish | Tools | [duit |

41
Hurmbars | Taxt | Fonts | Solors | Borders | Layout | Solumns | Bowe | Miec |
Cll Lawoul Aligament  Paddng All Calls
Cuse detask & Tep Top | [ Edit dafauke
1 cotpxplicithy |S pixels "l

C middle || gn 0 pels ""I IEpireli "'I Fught |

i 0piealz =

Bektarm

Shum Layout Settings | | cRangs | cancel | | Help |

LAYOI

£1,2345ar
57

102

b difs

Financial Information

Financial statements, reporns, filings

Consolidated statement of earnings

[dallars bn millione sxcept per chare smounse)
Far the yesr anded Decembaer 31

200F 2004 b3
Total Revenue 31,134 96,253 29,131
Totsl Coxt Fo92.602 FE0,T2e fo0.504
Grsds Profit $36,532 $35,569 $32.547
Total Expense and Cthes [ncorme $24,306 24,900 $23.1230

Incoms from Continuing Cperatiane sfiar §r.0%a FTa0T 6,500
Tazmi

Earnings per Share of Commvon Stodk From $d4.27 £4.33 $3.74
Continuing Operations Assuemning Cdution

= Datails of 2005 statement

Consolidated statement of financial position

{dallars in rrifkars)

Presentation and Database Programs

Presentation programs

= How to resd Finansial
itatemants

Presentation program — a program that is designed to present

information in the form of a slideshow, using multimedia formats such
as pictures, sounds, videos, and text. Such a program is commonly
used in education, training, business meetings, etc., to create powerful

presentations.
Presentation programs are commonly used to:

* Create slideshow presentations
* Create lectures and tutorials

* Make photo slideshows

» Design websites with hyperlinks and interactivity
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* Make photo albums
* Create animated videos (with voice and animation)

Examples of presentation programs include Microsoft PowerPoint, Google Slides, Apple Keynote,
Prezi, CustomShow, SlideDog, and Powtoon.

Database programs

Database program (database management system) — A program that is designed for creating,
editing, updating, maintaining databases, and managing organized information stored in them.

Databases are useful for keeping track of customers, users, employees, students, inventory, product
purchases, ISBN numbers, etc. Database programs are used in the following fields:

* Banking

 Airline/railway reservation

* Library management

* Education

* Human resource management

» Healthcare

* Weather

* E-commerce

* Government

* Sports

» Military

Examples of database programs include Microsoft Access, Oracle Database, Knack, TablePlus, and
TeamDesk.
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Launch and Terminate a Program

Launch an application program

Method 1

1.
1. Click the Start icon. -

2. Click the name of the program that you wish to
start (e.g., Word 2016).

Method 2

1. Type the program name in the Search box.

2. Click the name of the program that you want to launch.

Method 3

1. Double-click a program shortcut icon on the desktop, if
there is one.

Method 4

1. Click a program shortcut on the taskbar at the bottom edge of
the screen.

Close (exit) a program (close an active open window)

Method 1

1. Click the Close icon (x) in the upper-right corner of the window.

Method 2 (Apple)
1. Click File in the upper-left corner. IED) ecit View insert Fon
. New Document 38BN
2. Click Close. New from Template... {+3P
Open... #0
Open Recent »
Force close a frozen program C=s] P
Save #8S
Method 1 Save As... 388

Save as Template...

1. Click Alt + F4.
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Method 2

1. Click Ctrl + Alt + Delete to open Task Manager.
2. Select the unresponsive program and click End Task.

Media Attributions

Postkasse Business Presentation © Gravitaa - Design Matters is licensed under a CC BY-NC-ND (Attribution NonCommercial
NoDerivatives) license

Start Program © Microsoft. Used with permission.
Search © Microsoft. Used with permission.
» Apple File Menu © Apple. Used with permission.



https://search.creativecommons.org/photos/daba11fe-42f7-459d-9f2b-9c1198a14325
https://creativecommons.org/licenses/by-nc-nd/4.0/
https://creativecommons.org/licenses/by-nc-nd/4.0/
https://www.microsoft.com/en-us/legal/intellectualproperty/permissions/default.aspx
https://www.microsoft.com/en-us/legal/intellectualproperty/permissions/default.aspx
https://www.apple.com/ca/legal/intellectual-property/guidelinesfor3rdparties.html

Topic B: Types of computers

Classification of Computers by Size

* Supercomputers
* Mainframe computers
* Minicomputers

* Personal computers (PCs) or microcomputers

Supercomputers

Supercomputer — a powerful computer that can process large amounts
of data and do a great amount of computation very quickly.

Supercomputers are used for areas related to:

* Science

» Engineering
* Education
* Defence

» Aerospace

Supercomputers are useful for applications involving very large
databases or that require a great amount of computation.

Supercomputers are used for complex tasks, such as:

* Weather forecasting
 Climate research

* Scientific simulation

+ Oil and gas exploration
* Quantum mechanics

* Cryptanalysis
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Mainframe computers

Mainframe computer — a high-performance computer used for large
information processing jobs.

Mainframe computers are primarily used in :

* Institutions
* Research

* Academics
* Health care

» Libraries

» Large businesses
+ Financial institutions
 Stock brokerage firms

+ Insurance agencies
Mainframe computers are useful for tasks related to:

» Census taking

* Industry and consumer statistics
» Enterprise resource planning

* Transaction processing

» e-business and e-commerce

Minicomputers

Minicomputer — a mid-range computer that is intermediate in size,
power, speed, storage capacity, etc., between a mainframe and a
microcomputer.

Minicomputers are used by small organizations.

“Minicomputer” is a term that is no longer used much. In recent years,
minicomputers are often referred to as small or midsize servers (a server is a central computer that
provides information to other computers).
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Personal computers

Personal computer (PC) — a small computer designed for use by a
single user at a time.

A PC or microcomputer uses a single chip (microprocessor) for its
central processing unit (CPU).

“Microcomputer” is now primarily used to mean a PC, but it can refer
to any kind of small computer, such as a desktop computer, laptop
computer, tablet, smartphone, or wearable.

Types of personal computers

Desktop computer — a personal computer that is designed to stay at one location and fits on or under a
desk. It typically has a monitor, keyboard, mouse, and a tower (system unit).

Laptop computer (or notebook) — A portable personal computer that is small enough to rest on the
user’s lap and can be powered by a battery. It includes a flip down screen and a keyboard with a
touchpad.

Tablet — A wireless touchscreen PC that is slightly smaller and weighs less than the average laptop.



94 | Unit 6. Basic computer terminologies

Media Attributions

« Jaguar tunnel © Jody Mclntyre is licensed under a CC BY-SA (Attribution ShareAlike) license
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Topic C: Basic computer terminologies and acronyms

Basic Internet Terms and Acronyms

Internet — A globally connected massive computer network system.

World Wide Web (WWW or the web) — A system of Internet servers that is made from millions of
interlinked websites and web pages.

Firewall — A network security device designed to prevent unauthorized access to or from a network.

Router — A device that transfers data between computer networks to provide access to the Internet.
ISP (Internet Service Provider) — A company that provides Internet service to customers.

HTTP (Hypertext Transfer Protocol) — A set of rules (a protocol) for transferring and accessing data
using the web.

URL (Uniform Resource Locator) — A web address of a specific web page or file on the Internet. An
example is https://www.princegeorgecitizen.com.

IP (Internet Protocol) — A set of rules (a protocol) for sending data from one computer to another on
the Internet. Each computer has a unique IP address that distinguishes it from all other computers on
the Internet.

FTP (File Transfer Protocol) — A set of rules (a protocol) for transferring files between computers
over the Internet.

Cookie — A small text file stored in a user’s computer by a website that the user has visited so that it
can remember something about the user at a later time. For example, cookies are used for online
shopping. Without cookies, login information would have to be entered before every product was
added to the shopping cart.

Link (hyperlink) — A word, phrase, image, etc., within a file or web page that a user can click on to
jump to another document, section of the same document, or web page.
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Basic Computer Terms and Acronyms

PC (Personal Computer) — a small computer designed for use by a single user at a time.

Mac (Macintosh) — a type of personal computer made by Apple Inc. It runs a version of the macOS
(Apple’s operating system, pronounced “mack-oh-ess”).

r

OS (Operating System) — a powerful program that controls and coordinates a computer’s hardware
devices and runs software and applications. Examples includes Windows, Android, OS X, and Linux.

Reboot — to shut down and restart a computer, allowing its operating system and programs to be
reloaded.

CPU (Central Processing Unit) — the brain or engine of a computer, where most of the processing and
operations take place.

RAM (Random-Access Memory) — a type of data storage (memory element) used in computers that
temporarily stores programs and data. RAM is a kind of volatile memory, meaning its contents are lost
when the computer is turned off.

ROM (read-only memory) — A type of data storage used in computers that permanently stores data
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and programs. ROM is a kind of non-volatile memory, meaning its contents are retained even when the
computer is turned off.

Bits and Bytes

Bit (Binary Digit) — the smallest, most basic unit of measurement for
computer data storage, represented as either a 0 or a 1. One byte is
equal to 8 bits.

Byte (Binary Term) — a unit of measurement for data storage. One
byte is equal to 8 bits.

Data Storage Units and Their Properties

Data Storage Unit Symbol Power of 10 One Unit Equals
Byte B 10t 8 bits

Kilobyte kB 103 1024 B
Megabyte MB 10° 1024 kB
Gigabyte GB 10° 1024 MB
Terabyte B 102 1024 GB
Petabyte PB 10 1024 TB







Unit 6: Self-test

Find answers to this self-test at the back of the book: Answers for Self-Tests

True or false

An application program is a computer program that provides the user with tools to
accomplish a specific task.

A database is a program that organizes data into rows and columns. This data can then be
used to arrange, sort, calculate, analyze, or show graphical representations of data.

Common uses for spreadsheet programs include creating slideshow presentations, creating
lectures and tutorials, making photo slideshows, and making interesting animations.

To launch an application program, click the Start icon, then click the name of the program
that you wish to start.

Microcomputers are used for complex tasks, such as weather forecasting, climate research,
scientific simulation, oil and gas exploration, quantum mechanics, and cryptanalysis.

A firewall is a network security device designed to prevent unauthorized access to or from a
network.

HTTP is a word, phrase, image, etc. within a file on the computer that a user can click on to
jump to another document or section of that document.

Fill in the blank

10.

11.

12.

13.

14.

[Blank] is a program that allows users to create, save, edit, format, print, and retrieve
documents.

Common uses for a [blank] program include creating budgets, calculating grades, balancing
bank accounts, calculating loan payments, calculating tax, preparing payrolls, and financial
analysis.

A [blank] program is a program that is designed to present information in the form of a
slideshow.

[Blank] computers are primarily used by institutions, researchers, academics, healthcare
administrators, libraries, large companies and businesses, banking institutions, stock
brokerage firms, and insurance agencies.

The Internet is a globally connected massive computer [blank] system.

The World Wide Web is a system of Internet servers that is made from millions of interlinked
websites and [blank].

A [blank] is a small text file in the user’s computer stored by a website that the user has
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visited so that it can remember something about the user at a later time.

15. A [blank] is a powerful program that controls and coordinates a computer’s hardware devices
and runs other software and applications on a computer.

Multiple choice

16. A(n) [blank] is an example of application program.
a. accounting
b. translation
c. Internet browser
d. all of the above
17. Microsoft Office 2016 includes
a. Microsoft Excel
b. Microsoft Word
c. Microsoft PowerPoint
d. all of the above
18. To close a program:
a. click “View”
b. click “Tools”
c. click the close icon (x)
d. all of the above
19. To force close a frozen program, click [blank] at the same time.
a. Alt+F2
b. Alt+F4
c. Alt+F3
d. Alt+F1

20. A [blank] computer is a high-performance computer used for large information processing
jobs.

mainframe

o p

personal computer

0

laptop

.

desktop
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21. A [blank] is a device that transfers data between computer networks to provide access to the
Internet.

a. FTP
b. URL
c. router
d. ISP

22. A [blank] is often referred to as the brain or engine of a computer, where most of the
processing and operations take place.

a. mainframe
b. CPU
c. RAM
d. byte
23. A byte is a unit of measurement for data storage. 1 GB is equal to 1024 [blank].
a. kB
b. TB
c. PB
MB

L
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Basic Terms

Vacuum tube — an electronic device that controls the flow of electrons in a vacuum. It used as
a switch, amplifier, or display screen in many older model radios, televisions, computers, etc.

Transistor — an electronic component that can be used as an amplifier or as a switch. It is Q
used to control the flow of electricity in radios, televisions, computers, etc. //

Integrated circuit (IC) — a small electronic circuit printed on a chip (usually made of
silicon) that contains many its own circuit elements (e.g. transistors, diodes, resistors,
etc.).

Microprocessor — an electronic component held on an integrated circuit that contains a
computer’s central processing unit (CPU) and other associated circuits.

CPU (central processing unit) — It is often referred to as the brain or engine of a
computer where most of the processing and operations take place (CPU is part of =
a microprocessor).

Magnetic drum — a cylinder coated with magnetic material, on which data and programs
can be stored.

Magnetic core — uses arrays of small rings of magnetized material called cores to store information.
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Machine language — a low-level programming language comprised of a
collection of binary digits (ones and zeros) that the computer can read and

understand.

Assembly language is like the machine language that a computer can understand, except that assembly

language uses abbreviated words (e.g. ADD, SUB, DIV...) in place of numbers (0s and 1s).

Memory — a physical device that is used to store data, information and program

in a computer.

Artificial intelligence (AI) — an area of computer science that deals with the simulation and creation of
intelligent machines or intelligent behave in computers (they think, learn, work, and react like humans).

First Generation of Computers

Classification of generations of computers

The evolution of computer technology is often divided into five generations.

Five Generations of Computers

Generations of computers

Generations timeline

Evolving hardware

First generation

1940s-1950s

Vacuum tube based

Second generation

1950s-1960s

Transistor based

Third generation

1960s-1970s

Integrated circuit based

Fourth generation

1970s-present

Microprocessor based

Fifth generation

The present and the future

Artificial intelligence based
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The main characteristics of first generation of computers (1940s-1950s)

* Main electronic component — vacuum tube

* Main memory — magnetic drums and magnetic tapes

* Programming language — machine language
* Power — consume a lot of electricity and generate a lot of heat.

* Speed and size — very slow and very large in size (often
taking up entire room).

+ Input/output devices — punched cards and paper tape.

+ Examples — ENIAC, UNIVACI1, IBM 650, IBM 701,
etc.

* Quantity — there were about 100 different vacuum tube computers produced between 1942
and1963.

Second Generation of Computers

The main characteristics of second generation of computers (1950s-1960s)

* Main electronic component — transistor
* Memory — magnetic core and magnetic tape / disk
* Programming language — assembly language

* Power and size — low power consumption, generated less heat, and smaller in |
size (in comparison with the first generation computers).

* Speed — improvement of speed and reliability (in comparison with the first
generation computers).

* Input/output devices — punched cards and magnetic tape.
» Examples — IBM 1401, IBM 7090 and 7094, UNIVAC 1107, etc.

Third Generation of Computers

The main characteristics of third generation of computers (1960s-1970s)

* Main electronic component — integrated circuits (ICs)
* Memory — large magnetic core, magnetic tape / disk

* Programming language — high level language (FORTRAN, BASIC,
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Pascal, COBOL, C, etc.)

 Size — smaller, cheaper, and more efficient than second generation computers
(they were called minicomputers).

* Speed — improvement of speed and reliability (in comparison with the
second generation computers).

* Input / output devices — magnetic tape, keyboard, monitor, printer, etc.
» Examples — IBM 360, IBM 370, PDP-11, UNIVAC 1108, etc.

Fourth Generation of Computers

The main characteristics of fourth generation of computers (1970s-present)

* Main electronic component — very large-scale integration
(VLSI) and microprocessor.

+ VLSI- thousands of transistors on a single microchip.

* Memory — semiconductor memory (such as RAM, ROM,
etc.)

o RAM (random-access memory) — a type of data & “4 ,
storage (memory element) used in computers that temporary stores of programs
and data (volatile: its contents are lost when the computer is turned off).

o ROM (read-only memory) — a type of data
storage used in computers that permanently stores
data and programs (non-volatile: its contents are
retained even when the computer is turned off).

* Programming language — high level language (Python, C#,
Java, JavaScript, Rust, Kotlin, etc.).

oA mix of both third- and fourth-generation languages
* Size — smaller, cheaper and more efficient than third generation computers.

» Speed — improvement of speed, accuracy, and reliability (in comparison with the third
generation computers).

* Input / output devices — keyboard, pointing devices, optical
scanning, monitor, printer, etc.

* Network — a group of two or more computer systems linked
together.

» Examples — IBM PC, STAR 1000, APPLE II, Apple
Macintosh, etc.
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Fifth Generation of Computers

The main characteristics of fifth generation of computers (the present and the future)

* Main electronic component: based on artificial intelligence,
uses the Ultra Large-Scale Integration (ULSI) technology
and parallel processing method.

o ULSI — millions of transistors on a single
microchip

o Parallel processing method — use two or more
microprocessors to run tasks simultaneously.

» Language — understand natural language (human language).
* Power — consume less power and generate less heat.

* Speed — remarkable improvement of speed, accuracy and reliability (in comparison with the
fourth generation computers).

*+ Size — portable and small in size, and have a huge storage capacity.

* Input / output device — keyboard, monitor, mouse, trackpad
(or touchpad), touchscreen, pen, speech input (recognise
voice / speech), light scanner, printer, etc.

+ Example — desktops, laptops, tablets, smartphones, etc.
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The computer — this amazing technology went from a government/business-only technology to being
everywhere from people’s homes, work places, to people’s pockets in less than 100 years.

Media Attributions
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Topic B: Computer hardware and software

Computer Hardware Basics

Hardware — any physical device or equipment used in or with a computer system (anything you can
see and touch).

External hardware

» External hardware devices (peripherals) — any hardware device that is located outside the
computer.

+ Input device — a piece of hardware device which is used to enter information to a computer
for processing.

» Examples: keyboard, mouse, trackpad (or touchpad), touchscreen, joystick, microphone, light
pen, webcam, speech input, etc.

* Output device — a piece of hardware device that receives information from a computer.

» Examples: monitor, printer, scanner, speaker, display screen (tablet, smartphone ...),
projector, head phone, etc.
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Internal hardware

 Internal hardware devices (or internal hardware components) — any piece of hardware
device that is located inside the computer.

» Examples: CPU, hard disk drive, ROM, RAM, etc.

Computer Software Basics

Computer software

» Software — a set of instructions or programs that tells a computer what to do or how to
perform a specific task (computer software runs on hardware).

* Main types of software — systems software and application software.

Application software

» Application software — a computer program that provides o
users with tools to accomplish a specific task. % —

-~/
» Examples of application software: word processing, @ ~/

spreadsheets, presentation, database management, Internet \/@

browsers, email programs, media players, accounting,
pronunciation, translation, desktop publishing, enterprise,
etc.

System Software

System software — it is designed to run a computer’s hardware and application software, and make the
computer system available for use. It serves as the interface between hardware, application software,
and the user.
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» Main functions of system software — allocating ——
system resources, managing storage space, storing USEr
and retrieval of files, providing security, etc.

* Main types of systems software — operating

system, device driver, utility software, A‘F‘PLLGQ{:E,,QW
programming software, etc.

Operating system (OS) — a software that controls and
coordinates the computer hardware devices and runs other .{")‘P firﬂt'[..m,g.. S L"I CTENL
software and applications on a computer. It is the main part =
of system software and a computer will not function without
1t.

SO OWAYe,

* Main functions of an operating system — booting
the computer, managing system resources (CPU,
memory, storage devices, printer, etc.), managing files, handling input and output, executing
and providing services for application software, etc.

» Examples of operating system: Microsoft Windows, Apple iOS, Android OS, macOS, Linux,
etc.

Device driver — a software program that is designed to control a particular hardware device that is
attached to a computer.

+ The main purpose of device driver — it acts as a translator between the hardware device and
operating systems or applications that use it.

+ It instructs computer on how to communicate with the device by translating the operating
system’s instructions into a language that a device can understand in order to perform the
necessary task.

» Examples of device driver: printer driver, display driver, USB driver, sound card driver,
motherboard driver, ROM driver, etc.

Utility software — a type of system software that helps set up, analyze, configure, strengthen, maintain
a computer and performs a very specific task (e.g. antivirus software, backup software, memory tester,
screen saver, etc.).






Unit 7: Self-test

Find answers to this self-test at the back of the book: Answers for Self-Tests

True or false

A vacuum tube is an electronic device that controls the flow of electrons in a vacuum.

A transistor is an electronic component held on an integrated circuit that contains a
computer’s CPU and other associated circuits.

A magnetic drum uses arrays of small rings of magnetized material called cores to store
information.

Assembly language is like the machine language that a computer can understand, except that
assembly language uses abbreviated words in place of numbers.

Internal hardware devices are any hardware device that is located outside the computer.

Hardware is a set of instructions or programs that tells a computer what to do or how to
perform a specific task.

Operating system (OS) is a software that controls and coordinates the computer hardware
devices and runs other software and applications on a computer. It is the main part of system
software and the computer will not function without it.

Utility software is a type of system software that helps set up, analyze, configure, strengthen,
maintain a computer and performs a very specific task.

Fill in the blank

10.

11.

12.

13.
14.

15.

A [blank] is an electronic component that can be used as an amplifier or as a switch. It is used
to control the flow of electricity in radios, TV, computers, etc.

The [blank] is often referred to as the brain or engine of a computer where most of the
processing and operations take place.

[Blank] is a low-level programming language comprised of a collection of binary digits (ones
and zeros) that the computer can read and understand.

[Blank] is an area of computer science that dealing with the simulation and creation of
intelligent machines or intelligent behave in computers.

The [blank] language was used in first generation of computers.

An [blank] device is a piece of hardware device which is used to enter information to a
computer for processing.

[Blank] software is designed to run a computer’s hardware and application software, and
make the computer system available for use. It serves as the interface between hardware,
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application software, and the user.

16. A [blank] driver is a software program that is designed to control a particular hardware
device that is attached to a computer.

Multiple choice

17. [Blank] is a small electronic circuit printed on a chip usually made of silicon that contains
many its own circuit elements

a. a microprocessor

b. avacuum tube

C. atransistor

d. an integrated circuit

18. [Blank] is a cylinder coated with magnetic material, on which data and programs can be
stored.

a. a magnetic core

b. avacuum tube

c. amagnetic drum

d. an integrated circuit

19. [Blank] is a physical device that is used to store data, information, and program in a
computer.

a. a magnetic core
b. computer memory
c. amagnetic drum
d. an integrated circuit
20. The main electronic component used in first generation of computers was:
a. transistor
b. CPU
c. integrated circuit
d. vacuum tube
21. Which language was used in second generation of computer?
a. assemble language
b. machine language

C++

N &

Java
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22. The main electronic component used in fourth generation of computers was:
a. transistor
b. CPU

VLSI

/e 0

vacuum tube






Unit 8. Operating system

Topic A: Basic pointing actions

* Pointing
* Scrolling
 Laptop touchpad

Topic B: Printer

* Operate a printer

* Get a printer online

Topic C: Basic operations of an operating system

» Files and folders
» Create folders

» Locate files and folders

Topic D: Copy, move, delete, and rename files/folders

» Copy files or folders
» Move files or folders

* Delete and rename files or folders

Unit 8 Self-test
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Topic A: Basic pointing actions

Pointing

Point and click

» Pointing device — a device used to control the movement of the pointer (cursor) on the
screen.

» The major pointing devices in use today are the mouse, trackpad or touchpad (laptop), touch
screens, etc.

» Point and click — point an object on the screen and then press a button on the mouse to select
objects / commands, open menus / hyperlinks (links), or close windows.

* Double-click — quickly click the left mouse button twice on any folder, file, or program to
open it.

Left mouse button Right mouse button

Left and right click

» Left-click — press the left mouse button on the left side of the mouse. Left-click is often
referred to as “regular-click” and it is used for many common computer tasks, such as
selecting objects, closing windows, opening hyperlinks, double-clicking, etc.

» Right-click — press the right mouse button on the right side of the mouse to display a popup
menu showing commands for a selected item.

Scrolling

Scroll bar

* Scrolling — sliding content (text, images, etc.) vertically or horizontally on a computer screen
and allowing the user to view different parts of information in a window.
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* Vertical scroll bar — a vertical bar on the right side of a window or screen
that allows the user to scroll the window viewing area up or down.

* Horizontal scroll bar — a horizontal bar on the bottom of a window or
screen that allows the user to scroll the window viewing area to the left or
right.

K T | )

Scrolling

-

* Vertical scrolling — sliding content up or down on a computer screen using a vertical
scroll bar.

* Horizontal scrolling — sliding content left or right on a computer screen using a horizontal
scroll bar.

Drag and drop — press and hold the left mouse button to grab an object (such as an icon on the
desktop) and place it to a different location.

Laptop Touchpad

Laptop touchpad (or trackpad) — an input device for laptop computers that is made up of a flat,
touch-sensitive surface. It provides a way to move the cursor around the screen or give an instruction
(highlight text, select and open applications, etc.).

Use a laptop touchpad (or trackpad)

* Tap (click) — point an object on the screen and then tap on
the trackpad to select items / commands, open menus /
hyperlinks (links), or close windows.

* Double tap (double click) — double tap on the trackpad on
any folder, file, program, word, etc. to open / select it.

* Drag and drop — double-tap the trackpad to grab an object
and place it to a different location. Example: drag the selected text to the new location.

+ Right-click — tap two fingers anywhere on the trackpad to display a popup menu showing
commands for a selected item.
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Popup menu

G o I e Reload Page
Open in Dashboard...

Save Page As...
Print Page...

Block element

Google Search I'm Feeling Lucky

* Scrolling — tap two fingers on the trackpad and slide fingers up or down to scroll.

+ Select — swipe in from the left or right of the sentence or word (tap the right or left of the
sentence or word and swipe towards the other side).

Media Attributions

¢ scroll-bar-vertical © OpenClipart-Vectors (Pixabay licence)
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Topic B: Printer

Operate a Printer

How to operate a printer

Printer — a device that is usually connected to a computer in order to transfer
the text and graphic information to paper.

Turnon a printer

1. Plug the printer into a working wall outlet.
2. Make sure the power cord is connected to the rear of the printer.

3. Press the Power button on the printer.

Load paper in the paper tray

1. Pull the paper tray out.

2. Load paper in the centre paper tray.

3. Adjust the paper guides to fit the paper size (if necessary).

Paper guide

4. Push paper tray completely into the machine.
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Get a Printer Online

If a printer is showing an offline message, it means it can’t communicate with the computer. Bringing a
printer online means it can communicate with the computer and it can read and print.

© Canon Printer - USBOD1 =l

Option  Help

Frinter Status

Printer iz affine,

Paper Thickness Lever Position;

Dwner DP&ZMIMD
Document Marme:  Test Page
Printing Pages:

[Emcel Printingl IDispIa_',l Prink E!ueue]

Get a printer online

1. Click Start button. E

2. Type Devices Manager in the search box.

£ Devices Manager |

3. Click Devices Manager.
4. Click the Action tab (in the top-menu).
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(et a printer online

;.].-_ Device Manager

File

B O @

Action | View Help

&= @ HE B

Best match

‘?: Device Manager
' Contral panel

Search the web

AL Device Manager - See web results

5. Click on the Devices and Printers.

o Device Manager
File = Action View Help
@ = Devices and Printers
v |2 Help
> W AU TpUTS ano ouTpuTs
5 ﬁ Batteries

v & P3-364-01

i| Audio inputs and outputs
£ Computer

o Disk drives

& Display adapters

- DVD/CD-ROM drives
Hiuman Interfare Nevicee

6. Right-click on the Offline Printer (it appears faded).

7. Click on See what’s printing.

s Devices and Printers

<« « 4 Ha » Control Panel » Hardware and Sound » Devices and Printers

File Edit View Tools

Add a device Add a printer See what's printing

~ Printers (4)

Print server properties

p Open

Open in new window

&

See what's printing

Set as default printer

Fax Hewlett-Pac|
HP Laserlet P
MFP M127fn

Printing preferences

Printer properties

8. Click on the Use Printer Offline.
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M Hewlett-Packard HP Laserlet Pro MFP M127fn -

Printer §Document  View

Connect Status

Set As Default Printer

Printing Preferences...

Update Driver
Pause Printing

Cancel All Documents

Sharing...
|. Uze Printer Offline

Properties

Cloze

Read more on How to Make Printer Online in Windows 10.


https://www.techbout.com/make-printer-online-in-windows-10-27811/

Topic C: Basic Operations of an Operating System

Files and Folders

Operating system

Recall: operating system (OS) — a software that controls and coordinates the computer
hardware devices and runs other software and applications on a computer. It is the main part
of system software and the computer will not function without it.

Main functions of operating system — booting the computer, managing system resources
(CPU, memory, storage devices, printer, etc.), managing files, handling input and output,
executing and providing services for application software, etc.

Examples of operating system: Microsoft Windows, Apple iOS, Android OS, macOS, Linux,
etc.

Files and folders

Folder (or directory) — a virtual storage space used to store and organize computer files.

o A folder can also contain additional folders (subfolder — a folder within another
folder).

o A folder has a name and is represented by an icon .

File — a storage unit on a computer that stores information or data (such as a document, an
image, etc.).

o Folders contain files.
o Files have names and are represented by various icons.

Filename — a unique name given to a file to identify it. A filename can contain letters,
symbols, numbers, spaces, etc.

Files hierarchy — a file system that organizes folders and files in a top-to-bottom structure.
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Create Folders

Right-click to create a new folder (Windows 10)

1. Go to the location where you wish to

View >
create the folder (Desktop, Documents Sort by >
or anywhere on your computer). Refresh

Paste

2. Right-click on a blank space (don’t Paste shortcut
Undo Delete Ctrl+Z

right-click on an existing item in the
folder).

Click or hover over New.

4. Click Folder.

B Intel® Graphics Settings

>

#| Shortcut

=1 Display settings
& Personalize B5 Microsoft Access Database

& Bitmap image
5. Type a name for the new folder and
press Enter (on a keyboard).

Create a new folder from the ribbon menu (Windows 10)

Ribbon — a group of buttons and icons (tabs) at the top of the window. It allows users to access the
commands that they need to complete a task.

Cut K L_'_l Mew item - v"; Open
.| Copy path EJ Easy access = Edit
ck Copy Paste Move Copy Delete Rename Mew Properties )
| Paste shortout to to - folder - &2 History

Clipboard Organize Mew Open
1. Go to the location where you wish to create the folder (e.g. Documents).

2. Click Home.

3. Click New folder.

4

Type a name for the new folder and press Enter (on a keyboard).

Share View

§ Cut N/ ‘7 New item ~ Open
= A . v
- w.| Copy path T | Easy access ~ = Edit
ick Copy Paste Move Copy Delete Rename New Properties
|#| Paste shortcut to to - folder - &) History

Clipboard Organize New Open
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Locate Files and Folders
Locate files and folders - search from the taskbar (Windows 10)

1. Type the name of a file or folder (or a keyword from it) into the Search Box
(next to the Start Button).

2. Click the matching file or folder name to open it.

Locate files and folders - File Explorer option (Windows 10)

1. Click File Explorer icon (on the taskbar or Start Menu).

2. Go to the location where stores your file or folder (hard drive, USB, etc.).
3. Click the name of the file or folder you wish to open.

4. Double click the file or folder name.

v < | Math 045 - 0 X
“ Home Share View e
« v » ThisPC » My Network Drive () » Math Courses » Math 045 v @ Search Math 043 »

~
v [ This PC ~ Mame Date modified Type Size
J 3D Objects Book - Algebra_Test_Prep_Rvw.pdf Adobe Acrobat D... 9115 KB
[ Desktop M= Math 045 TRIGONOMETRY Notes.docx Microsoft Word D... TI3KB
7 M= UNIT1 1.7 (First part) Handout.docx Microsoft Word D... 96 KB
=| Documents . . ) )

M= Unit 1 (Proofreading).doce Microsoft Word D... 410KB

J Downloads 1 ; . . -
0= Unit 2 { new 2).docx Microsoft Word D... 673 KB
& Music ] Unit 7 (4rd).docx Microsoft Word D.. 48 KB
v [&=] Pictures 0= Unit 8 (3rd).docx Microsoft Word D... 608 KB
Camera Roll [=| Unit 9 (3rd).docx Microsoft Word D... 2,141 KB

Saved Pictures
Screenshots
B videos
o Windows ()
== Global Share (R:)
== Prince George (5:)
v == My Metwork Drive (Us)
v Math Courses
Math 028
Math 029
Math 030
Math 045
Mei's Folder

8items E‘ E






Topic D: Copy, move, delete, and rename files/folders

Copy Files or Folders

Copy a file or folder (Windows 10)

Method 1: Right-click

Click File Explorer icon.
Go to the location where stores your file or folder (hard drive, USB, etc.).
Click the name of the file or folder you wish to copy.

Right-click the highlighted file or folder and click Copy.

N

~ Mame Date modified Type

(%] Book - Algebra_Test_Prep_Ruvw.pelf 2114/2014 B:40PM  Adobe Acrobat

@Y Math 045 TRIGOMOMETRY Katar darv 400 {3010 0 SR ARA Microsoft Ward
QY UNIT1 1.1 (First Open licrosoft Word
@5 Unit 1 (Proofread Edit licrosoft Ward
@ | Unit 2 { new 2).d{ New y

@ | Unit 7 (drd).docx Print i .
@ Unit & (3rd).docx| [ Scan with Windows Defender... ficrosoft Word
@ Unit 9 (3rd).docx) | Share f

Open with...

Always available offline

Restore previous versions
Send to bl

Cut

Create shortcut
Delete

5. Go to the destination folder, right-click the destination folder and click Paste.

Send to

Cut

Copy
Paste

Delete

Rename
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Method 2:

LN

v

Ribbon toolbar commands

Click File Explorer icon.

Go to the location where stores your file or folder (hard drive, USB, etc.).
Click the name of the file or folder you wish to copy.

Click the Home tab at the top (on the ribbon). Share  View

I oy Cut

Click the Copy button. = = W=/ Copy path ¢

k | Copy | |Paste e A Move Copy
Go to the destination location, click the Home = T ' tor o~
tab. Clipboard Organ

fuves @ | Math 045 TRIGONOMETRY

Tusic @] UNIT 1 1.1 (Eirst part) Har
Click the Paste button. — _ _p

ast & Unit 1 (Proofreading).docx

ideos 2| Unit 2 ( new 2).docx

Move Files or Folders

Move a file or folder (Windows 10)

Method 1

ok o=

Click File Explorer icon.

Go to the location where stores your file or folder (hard drive, USB, etc.).
Click the name of the file or folder you wish to move.

Click the Home tab at the top (on the ribbon).

Click the Move to button.
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File Home Share View
_rie J
» Bke Q@ X =

w.. Copy path

Pin to Quick Copy Paste Move | Copy Delete Rename
access |1] Paste shortcut tow to~- -
Clipboard |%] Documents
_ ' Math 029 = pict
D loads o &= Pictures
"_’ awniacs Math 030
= Documents Math 045 Word Files - Open Text Notes
= Pictures + D Music
.ﬁ Music B videos
B videos B Desktop
Word Files - Ope 4 Downloads
) .—_[ Documents
[a5] OneDrive
J'g Music
& This PC [ Pictures
) 3D Objects ! Videos

- Desktop Choose location...

6. Click Choose Location (if you don’t find the right spot on the drop-down menu).
7. Go to the location you want to move for this folder.

8. Click Move.

Move ltems X

Select the place where you want to move ‘Unit 7
(4rd).docx', then dick the Move button,

Prince George () ~

My Metwork Drive (U:)
Math Courses
Mei's Folder

o Libraries

g Network

4l Recycle Bin

-
=~
-
=

Folder: | My Network Drive (U:)

] e T

Method 2
1. Click File Explorer icon.
2. Go to the location where stores your file or folder.
3. Click the name of the file or folder you wish to move.
4. Hold down the right mouse button and drag the file or folder to the location you wish to

move.
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Difference between copying and moving files / folders

» Copying — make a duplicate of the selected file or folder and place it in another location.

* Moving — move the original files or folder from one place to another (change the
destination).

» The move deletes the original file or folder, while copy creates a duplicate.

Delete and Rename Files or Folders

Delete a file or folder (Windows 10)

1. Click File Explorer icon.
2. Go to the location where stores your file or folder.
3. Click the name of the file or folder you wish to delete.
4. Press the delete key (on the keyboard) or right click the file or
folder and click Delete. Cut
Copy

Recover a deleted file or folder
Create shortcut

Delete

Recycle Bin

oD

Google
Chrome

2. Right-click the name of the file or folder (that you wish to recover). ...
3. Click Restore. (The file or the folder will be B5 ACDLLEI 3010 Timet abin doc

restored to its original location.) g o

o
Rename files or folders i 5c Cut

Delete

1. Click File Explorer icon. Properties
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2. Go to the location where stores your file or folder.
3. Right click the name of the file or folder you wish to rename.
4. Click Rename (on the menu that opens up). Pin to Start
5. Type a new name for the file and press Enter. " Sendto
Note: Cut
Copy

 If afile is in use, Windows will not allow you to rename the file.
Create shortcut

* Do not change the file extension of a file when renaming the file
(file extensions often indicate the file type, file format, etc.).

Delete

Properties






Unit 8: Self-test

Find answers to this self-test at the back of the book: Answers for Self-Tests

True or false

A pointing device is a device used to control the movement of the keyboard on the screen.

Point and click — point an object on the screen and then press a button on the mouse to select
objects / commands, open menus / hyperlinks, or close windows.

Scrolling — sliding content vertically or horizontally on the keyboard and allowing the user to
view different parts of information in a window.

Tap (click) — point an object on the screen and then tap on the trackpad to select items /
commands, open menus / hyperlinks, or close windows.

If a printer is showing an offline message, it means it can communicate with the computer.
A folder cannot contain additional folders.

The copy deletes the original file or folder, while move creates a duplicate.

Fill in the blank

10.

11.

12.
13.
14.

The major pointing devices in use today are the mouse, trackpad or [blank], touch screens,
etc.

Drag and drop — press and hold the [blank] mouse button to grab an object and place it to a
different location.

A laptop trackpad is an input device for laptop computer that is made up of a flat, [blank]-
sensitive surface. It provides a way to move the cursor around the screen or give an
instruction.

Drag and [blank] — double-tap the trackpad to grab an object and place it to a different
location.

A printer is an [blank] device linked to a computer. It transfers the information to paper.
Files have names and are represented by various [blank].

Files [blank]- a file system that organizes folders and files in a top-to-bottom structure.
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Multiple choice

16. [Blank]-click — quickly click the left mouse button twice on any folder, file, or program to
open it.

a. right

b. double

c. left

d. all of the above

17. Horizontal scrolling — sliding content [blank] on a computer screen using a horizontal scroll
bar.

a. right

b. up and down

c. left or right

d. all of the above

18. Double tap — double tap on the [blank] on any folder, file, program, word, etc. to open / select
it.

a. keyboard

b. trackpad

C. screen

d. all of the above

19. [Blank] — tap two fingers anywhere on the trackpad to display a popup menu showing
commands for a selected item.

a. right-click
b. up-click
c. left-click
d. double-click

20. Main functions of operating system:
a. managing system resources
b. handling input and output
c. booting the computer

d. all of the above
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21. Examples of operating system:
a. AppleiOS
b. Linux
c. Windows

d. all of the above

22. A filename can contain:
a. spaces
b. numbers
c. letters
d. all of the above

23. A [blank] is a group of buttons and icons at the top of the window. It allows users to access
the commands that they need to complete a task.

a. tab
b. ribbon

C. menu

L

all of the above






Unit 9. Basic word processing skills

Topic A: Basic word processing

» Create and edit a document
» Select and delete text

» Copy and paste

Topic B: Save, retrieve, and print files

» Save and retrieve files
» Print files
» Check spelling and grammar

+ Find synonyms

Topic C: Margins and alignment

» Formatting and page layout
* Document margins

 Text justification and alignment

Topic D: Formatting

» Bold, italic, and underline
* Line spacing

* Use help features

Unit 9 Self-test
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Topic A: Basic word processing

Word processing — the use of a program (software application) running on a computer that allows
users to create, edit, format, and store documents.

Create a Document

Steps to create a new word processing document (Word, )
Office 365):

New

1. Start Microsoft Word.
2. Click the File tab.

3. Click the New tab.
4

. Click Blank document. (A new blank
document appears.)

5. Type your text. The text you type will be
inserted into the document.

Blank document

Edit a Document

Editing a document — making revisions to a document, focusing on correcting errors, improving the
accuracy of language, rearranging, making words and sentences clearer and more effective, etc.

Editing in word processing may include the following tasks:

* Adding text (terms, phrases, paragraphs, etc.)
* Deleting a part of a text

* Copying text

* Moving text

» Pasting text

* Checking for grammar and spelling

* Formatting text

Select Text

Before editing text, you’ll need to select it. This is also sometimes called “highlighting text.”
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1. Click File Explorer icon.
2. Go to the location where stores your file or folder (hard drive, USB, etc.).

3. Open the document you wish to edit.

4. Move the I-beam pointer - to where you wish to select text.
1. To select a word: double-click the word.
2. To select an entire line of text: move the I-beam to the left of the line until it turns
into a right-pointing arrow , , then click.
3. To select a paragraph: triple-click the paragraph.
4. To select any amount of text: click and drag the I-beam over the text to highlight it.

5. To select an entire document: move the I-beam to the left of any text until it turns

into a right-pointing arrow , , then triple-click. Or click the Home tab, under
Editing, click Select, and then click Select All.

Delete (or remove) text

Method 1

1. Select the text you wish to delete.
2. Press the Delete key (on the keyboard).

Method 2

Eile Edit “iew Insert Format Tools Table Window Help

|
DR alky =2 |8l B2

J -

R S TSR A B AR B

~ Insertion Point
I (/
-~
/

~ |-Beam

1. Move the I-beam pointer to the text you want to delete. Click to set the insertion point there
(a blinking vertical line).

2. To delete text to the left of the insertion point, press the Backspace key on the keyboard. (On
a Mac keyboard, press the Delete key.)
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F10 F11

1 ( ) — + Backsp:ace
HF M
{ }

Fiz

||
I~ o
R
=

=

3. To delete text to the right of the insertion point, press the Delete key on the keyboard. (On a
Mac keyboard, press the fn key plus the Delete key.)

Copy and Paste

Copy vs. cut

* Copy — duplicates the selected item (text, symbol, table, image, etc.).

* Cut — removes the selected item from its original position.

Copy and paste vs. cut and paste
» Copy and paste — duplicates the selected item. The selected item can be found in both
original and the new, pasted location(s).

+ Cut and paste — duplicates the selected item then deletes the original. The selected data can
be found only at the new, pasted location (the item has moved from one location to another).

Steps to copy / cut and paste

Method 1

1. Open the document you wish to edit.

2. Select the item you wish to Copy or Cut.

3. Right-click the highlighted item and click Copy or Cut. You can also use your keyboard:
a. Copy: Cntr + ¢ (On a Mac, it is Cmd + ¢)
b. Cut: Cntr + x (On a Magc, it is Cmd + x)
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B I QE‘E‘JVATEE

X% | Cut

E® | Copy

m Paste Options:

e, o elds, a0, el

= Ls L@ LA

IEB’;

4. Position the insertion point where you wish to insert the item.

5. Right-click and click the Paste [%} icon. You can also use your keyboard by pressing Cntr
+ v (On a Mac, it is Cmd + v).

B I U ¥« - .

m Paste Options:

s, ldds, (s o=

= s L& LA

Method 2

1. Open the document you wish to edit.
2. Select the item you wish to copy or cut.

3. Click the Home tab at the top (on the ribbon). Click the Copy button.

Home Insert Design Layou

.8
D %CUt Times New Re = |12
EE{ Copy
Paste .
. ~ Format Painter B I U ~ax,

4. Position the insertion point where you wish to insert the item.

5. Under the Home tab at the top, click the Paste button.
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Home Insert Design
oD

D Cx’ oL Times New Ro ~
ER Copy
Paste .
= ¥ Format Painter B I U-a&

Review a Document

Check Spelling and Grammar

Method 1

1.
2.

Method 2

Open the document you wish to edit.

Right-click a word that is underlined with a wavy line (that indicates a misspelled word).

= Open the dacument vou wish to edit. ...
| document |

Ignore Al
Add to Dictionary

* Click the Review tg
» Click Spelling & G

Add to AutoCorrect >

Select the correct spelling from the suggestion list to correct the spelling error. For each error,
Word will offer one or more suggestions.

Open the document you wish to edit.
Click the Review tab.

Click the Editor button (it may also say, “Spelling and Grammar”). If the program finds
spelling errors, the Spelling & Grammar pane will appear.

File Home Insert Draw Design Layout References Mailings Review

/ Editor A)) - 3 ] g% Z3 ink Corr
(¥ L
Thesaurus 7 ] 2

.

Read Check Language New
=123 Word Count Aloud | Accessibility 5 Comment [ Show Comments
Proofing Speech Accessibility Comments

Click one of the options from the suggestion list to change the spelling error. The program
will move to the next misspelled word.



150 | Unit 9. Basic word processing skills

Find Synonyms
Method 1
1. Open the document you wish to edit.
2. Right-click a word for which you wish to find a synonym for.
3. Click the Synonyms command from the pop-out menu.
4. Find a desired word in the list and click it to replace the original word.
5. If none of the synonyms are desired, click the Thesaurus command to open the full

Method 2

1
2
3.
4

5.
6.

thesaurus. (The Thesaurus pane will appear.)
Find a desired word in the Thesaurus pane list and right-click it and then click Insert.

Close the Thesaurus pane.
_Thesaurus pane

-
-~

Saparate List and right-click Thesaurus v p
aenu that open
€ | document e
A Font
=q Paragraph... 4 text (n.)
SO Smart Lookup xnowledge text b
facility i e -
knack article
X% Translate -8 Lopy
) grasp essay
& Link I paper
3 New Comment —_— manuscript
deed
Open the document you wish to edit.
Select a word for which you wish to use the thesaurus.
Click the Review tab.
Click the Thesaurus button.
File Home Insert Draw Design Layout References Mailings Review
/£ Editor A)) . A +| | 1 _| el Z1 Ink Con
e T ™
Thesaurus Read Check Language New :
123 Word Count Aloud | Accessibility 2 Comment [ Show Comments
Proofing Speech Accessibility Comments

Find a desired word in the “Thesaurus” pane and right-click it and then click Insert.

Close the Thesaurus pane.



Topic B: Save, retrieve, and print documents

Save and Retrieve Documents

Save a new document or save a file to a specific location (Windows 10)

1. Click the File tab.

File Home Insert Design Layou
e
D gg s Times New Ro ~ |12
i[5 Copy
Paste -
- ¥ Format Painter BRI

2. Click the Save As command.

Save As
@ Recent

@ OneDrive

E;] This PC
3. Choose a location on your computer (the drive and folder) to save your file.

4. Type a name for your document in the File Name box.

5. Click the Save button.
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£ Videos

OpenText 9/1/2019 11:01

i Local Disk (C:) B2 Unit Added (Square roots).docx 2/20/2017 11:3
== Global Share (R:)

== Prince George (5:)

= My Network Drive (U:)

f Network

L ¢

| File name: | Section Jdocx

Save as type: | Word Document (*.docx)

Authors: Microsoft Office User Tags: Addatag

Hide Folders

D'Sa'.-'e Thumbnail

R

Save an existing file in its current location

1.
2.
3.

Click the File tab.
Click the Save command.

Or click the Save button icon.

Info

Section 2 - Unit 9

U: » Mei's Folder » Books » Computer O

Protect Doct
Control what types

Protect

Retrieve a file from a specific location

Eal D

o1

File Home Insert Design Layou|
Start Word. o
& Cut Times New Ro = |12
Click the File tab. pace B Copy

N : B I U ~abe X
- ¥ Format Painter = :

Click Open command.

Info

Section 2 - Unit 9

U: » Mei's Folder » Books » Computer O

Choose the location on the computer that stores your file (the §
drive and folder).

Click the name of the file you wish to open.
Protect Doct

Control what types

Click Open or double click the file name.
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Print a Document

Printer — a device that is usually connected to a computer in order to transfer the text and graphic
information to paper.

How to print a document in Microsoft Word:

Load paper in the paper tray if needed.

Press the Power button to turn the printer on.

1.
2
3. Choose the location on the computer that stores your file (the drive and folder).
4. Open the file you wish to print.

5

Click the File tab.

File Home Insert Design Layou
o
S 3{) Cut Times New Ro ~ |12
ER Copy
Paste =
> ~ Format Painter S e sy

6. Click the Print command.

Info

New

Section 2 - Unit 9

U: » Mei's Folder » Books » Computer Open Text » Units » Section 2

Open

Save

Protect Document

SRS /’ Control what types of changes people can
Protect make to this document.
Document -
('5)' \ Inspect Document
N Before publishing this file, be aware that it
Check for contains:
Issues Document properties, author's name,

related dates and cropped out image
Aata

7. Select the print options. Here, you can select:

o How many copies you would like

o Which pages you want to be printed. You can choose to print all pages, select pages
(for example, page 3 to 6), or just the current page (meaning the page that is open
on the screen).

o If the printer should print on one side of the page or both sides.
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Print

New

Printer

OnelNote

'% Ready -

Printer Properties

Settings

|—[D Print All Pages .

The whole thing
Decument

L Print Selection
"] Just what you selected

Feedback D Print Current Page
Jusi Is page

Options

Account

|—'."- '“1 Custom Print
I Type specific pages, sections or rang

8. Click Print to start the printing process.

Print

Share

Export

Close

Account

Feedback

Copies: |1 .

Printer

OneMaote

% Ready T

Printer Properties

Settings

”D Print All Pages .

The whole thing

Pages:

Dl Print One Sided |

Only print on one side of th...

D Print One Sided
Only print on one side of the page

. Manually Print on Both Sides

=" Reload paper when prompted to pi



Topic C: Margin and alignment

Formatting — the appearance of a document. It is the shape, size, form, style, typeface, general

arrangement, etc. of a document.

Page layout — the arrangement of text, graphics, pictures, and other elements on a page. It describes

how each page of a document will appear when it is printed.

Basic page layout properties include

* Document margins
* Word / character spacing

» Line spacing

+ Size and position of figures / images

* The number of columns

* How headers and footers appear
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Document Margins

Set document margins (Word 2016)

1. Open the document you wish to set margins.

2. Click the Layout tab in the Ribbon.

Home Insert Design Layout References Mailings Review View

™, O TimesNewR... v 14 ~+ A~ Av g4~ % e [A] IS v IS v VT 6= =

Pasta@ BIgvmxzx-‘f&-;-ﬁ-A@ = = = =

Lg 2 1 1 2 3 4 5 6 7

3. Click the Margins button (in the Page Setup group).

File Home Insert Design Layout References Mailings Review View Help
T L['yOrientation ~ »= Breaks ~ Indent Spacing
— [ Size ~ :[JLine Numbers ~ 3= Left: 0" - 1= Before: 0pt N
|Maf9'"5 E= Col . Pt e == . ly= -
—4&= Columns = pT" Hyphenation ~ =g gight. 0 S Y= After  0pt :
Page Setup I Paragraph I~

4. Choose predefined margin settings (Normal) from the drop-down menu. (Or choose the
Custom Margins command and set the margins that you want.)

Normal

Narrow dr OD-dOWIl menu
Moderate
Wide

Mirrored

Custom Margins...
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Change the page margins for part of a document

1. Select the part of the document for which you wish to change margins.
2. Click the Layout tab in the Ribbon.

3. Click the Margins button (in the Page Setup group).

4

. Click the Custom Margins command and set the margins that you want.

Text Justification and Alignment
Text justification / alignment — refers to how the left and right edges of a paragraph align on a page.

Types of justification / alighment

Align Left | Justity

Center Align Right

Left-justification (flush left): align text along the left side (ragged on the right).
* Right-justification (flush right): align text along the right side (ragged on the left).

+ Center-justification: text is aligned to neither the left side nor right.

Justify (full justification): align text along the both left and right sides.
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Align the text left

1. Select the text that you wish to align.

2. Click the Align Left icon on the Home
tab (or press Ctrl + L or Cmd + L on a
Mac).

3. Left align (the standard layout — we
read from left to right) is the default
alignment for text in a Word document.

Align the text right

1. Select the text that you wish to align.

2. Click the Align Right icon (or press
Ctrl + R or Cmd + R on a Mac).

3. Right align is often used when
formatting tables of data, attributions to
authors of quotes, etc.

Center text

1. Select the text that you wish to align.

Flush left

If you are looking for a quick exam, homework guide, and
review book in Computer Studies, “Key Concepis af
Computer” is an excellent source. Skip the lengthy and
distracting books and instead use this concise book as a
guideline for your studies, quick reviewing and tutoring,

Flush right
If you are looking for a quick exam, homework guide, and
review book in Computer Studies, “Key Concepis of
Computer” is an excellent source. Skip the lengthy and
distracting books and instead use this concise book as a
guideline for your studies, quick reviewing and tutoring.

Center-justification
If you are looking for a quick exam, homework guide, and
review book in Computer Studies, “Key Concepis of
Computer” is an excellent source, Skip the lengthy and
distracting books and instead use this concise book as a
guideline for your studies, quick reviewing and tutoring,.

Full justification

If you are looking for a quick exam, homework guide, and
review book in Computer Studies, “Key Concepis of Computer”
is an excellent source, Skip the lengthy and distracting books
and instead use this concise book as a guideline for your
studies, quick reviewing and tutoring.

2. Click the Center Align icon (or press Ctrl + E or Cmd + E on a Mac).

3. Center-justified text is commonly used on title pages, chapter titles, headings, etc.

Justify text

1. Select the text that you wish to align.

2. Click the Justify icon (or press Ctrl + J or Cmd + J on a Mac).

3. Justification gives text a cleaner, more formal look. Justified text is often used in some

newspapers, magazines, books, etc.
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Bold, Italic, and Underline

* Bold — a typeface that makes a character thicker than the regular one. Boldfacing is often
used for emphasis, headings, subheads, highlight keywords, etc.

+ Ttalics — a type style with characters that slope to the right. Italic is often used to emphasize a
particular word, sentence, or particular part of a document.

* Underline — add a line underneath the text, in order to show its importance and draw
attention to the text.

Make text bold

1. Open the document you wish to format.
2. Select the text for which you wish to bold.
3. Click Bold icon on the Home tab (or press Ctrl/Cmd + B).

Times NewRom ~(12  ~ A" A" Aa~ A

[B]T Uveex, ¥ A- 2+ A-

Font l=

Make text italic

1. Open the document you wish to format.
2. Select the text for which you wish to make italics.

3. Click the Italic icon on the Home tab (or press Ctrl/Cmd + I).
Times New Rom ~(12  ~ A" A" Aa~ A
B[IJu v x ¥ A~ 2+ A~

Font I

Underline text

1. Open the document you wish to format.

2. Select the text for which you wish to underline.
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3. Click the Underline icon on the Home tab (or press Ctrl/Cmd + U).

Times NewRom ~(12  ~ A" A" Aa~ A
B I|U|l-a x ¥ A~ &« A~

Font l=

Single-spaced lines (1.15)

Line Spacing If you are looking for a quick study guide in
Computer Studies, this book is an excellent resource.

Skip the lengthy and distracting books and instead

Line spacing — the space between lines of text in a
paragraph.

use this book to guide your studies.

Double-spaced lines (1.5)
* Most users use either single-spaced lines (one- . ooking £ e study euide
line height) or double-spaced lines. Ifyou are looking for a quick study guide in

. . Computer Studies, this book is an excellent resource.
* Line spacing can make a document look

cleaner and easy to read. Skip the lengthy and distracting books and instead

use this book to guide your studies.
Set line spacing

Method 1 -

=iz mr == 2l T AaBbC
1. Open the document you wish to edit. = === [i=-]| & . T Norma
2. Select the text you wish to change the line Par 1.0
spacing. :
pacing 8 - 1+ 7 1.15
+r=
3. Click the Line Spacing icon *= " on the v | 1.5

Home tab in the Paragraph group.

=

Fd

4. Choose a line-spacing value from the drop-
down list.

(=]

(R

3.

L]

Method 2 : : :
Line Spacing Options...

1. Select the text you wish to change the line spacing.

2. Click the Paragraph dialog box launcher button (in the lower right corner of the “Paragraph”
group). Or right-click anywhere in the document and then click Paragraph.

Times NewRom ~(12  ~ A" A" Aa~ A | i=~:i=~ iz~ =32 2] 1

B I U+vabx ¥ A-F-A. | ===

,

I
]
£
L4

el

Font Paragraph
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3. Click the Indents and Spacing tab.
4. Choose a desired Line Spacing option.
5. Click OK.

| Indents and Spacing | Line and Page Breaks

General
Alignment: eft (RS
Outline level: | Body Text ~ Collapsed by default
Indentation
Left: 7.35 ems Special: By:
Right: Om = First line 0.27 cm=
DMirrorindents
Spacing
Before: O pt = Line spacing: Af:
After: 0pt = 1.5 lines ~ =

|:| Don't add space between paragraphs of the same style

Preview

Tabs... Set As Default Cancel

Method 3
Use keyboard shortcuts to set line spacing:

* Single-spacing: Ctrl/Cmd + 1
* Double-spacing: Ctrl/Cmd + 2
* 1.5-spacing: Ctrl/Cmd + 5

* 1.15-spacing: Ctrl/Cmd + 0

Use Help Features

Help menu / button — the user can click help button in Word to initiate a search, display the help
resources, and aid the user in their task.

Access help

* Method 1: Click the Help button on the title bar.
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Home Insert Design Layout

References

Mailings

Review

View

Help Q Tell me

TimesNewR~[12 - A" A" Aa~ A i=vi=-"c- €35 4 0 | A.BbCel AaBbCel AaB|

File Home Insert Design Layout

o\ ©

Help |Contact Feedback Show
Support Training

References

Mailings

T

* Method 2: Press the shortcut key F1 to open the Help window.

Help

Get started
Collaborate
Insert text

Pages & layouts

View

Help Tell me what

* Method 3: Use help tutorials. Click out this blog post: Word 2016 — Tell Me Tool

* Method 4: Get help in the form of a Screen Tip.

Screen Tip (Tool Tip) — a small text box (a hint) appears when the mouse point rest on a command,
icon, button, etc. It displays the name of the item and sometimes a brief description of its function and

the shortcut key for the command.

@ Footer v e @
e
@ Page Number ~ Box v As. E:|

Header & Footer Text

Header*' A v B
-

Add a Header

Headers help you to repeat content
at the top of every page.

They're useful for showcasing
information, like title, author, and
page number.

Jde

er @ Tell me more
| liner: press tne


https://www.word-2016.com/word-2016-tell-me-tool/

Unit 9: Self-test

Find answers to this self-test at the back of the book: Answers for Self-Tests

True or false

Formatting a document — making revisions to a document, focusing on correcting errors,
improving the accuracy of language, rearranging, making words and sentences clearer, more
effective, etc.

To select a paragraph: double-click the paragraph.

3. To delete text to the left of the insertion point: press the backspace key on the keyboard.

Text Justification / alignment refers to how the left and right edges of a paragraph align on a
page.

Left-justification: align text along the left side (ragged on the left).

Bold — a typeface that makes an image thicker than the regular one.

Line spacing — the space between lines of text in a paragraph / document. Line spacing can
make a document looks cleaner and easy to read.

Fill in the blank

10.
11.

12.

13.
14.

15.

16.

[Blank] refers the use of a program running on a computer that allows users to create, edit,
format, and store documents.

To select any amount of text: click and drag the [blank] over the text to highlight it.
Cut removes the selected data from its [blank] position.

A [blank] is a device that is usually connected to a computer in order to transfer the text and
graphic information to paper.

Formatting refers to the [blank] of a document. It is the shape, size, form, style, typeface,
general arrangement, etc. of a document.

[Blank]-justification: text is aligned to neither the left side nor right.

Italics — a type style with characters that slope to the [blank]. Italic is often used to emphasize
a particular word, sentence, or particular part of a document.

Underline — add a line [blank] the text, in order to show its importance and draw attention to
the text.

The user can click [blank] menu / button in Word to initiate a search, display the help
resources, and aid the user in his / her task.

163



164 | Unit 9. Basic word processing skills

Multiple choice

17. [Blank]-click refers to quickly click the left mouse button twice on any folder, file, or
program to open it.

a. right
b. double
c. left
d. all of the above
18. To select a [blank]: double-click the word.
a. document
b. word
c. paragraph
d. all of the above

19. [Blank] refers to the arrangement of text, graphics, pictures, and other elements on a page. It
describes how each page of a document will appear when it is printed.

a. formatting
b. editing
c. page layout
d. all of the above
20. Basic page layout properties:
a. the number of columns
b. how headers and footers appear
c. document margins
d. all of the above
21. Justify (full justification): align text along the [blank].
a. both left and right sides
b. centre
c. right side
d. all of the above



Unit 9: Self-test | 165

22. [Blank] is a small text box appearing when the mouse point rest on a command, icon, button,
etc. It displays the name of the item and sometimes a brief description of its function and the
shortcut key for the command.

a. formatting
b. page layout
c. ScreenTip

d. all of the above






Unit 10. More on word processing

Topic A: Headers, footers, page numbers, and bullets

Create headers in a document
» Create footers in a document

* Insert page numbers

Create a bulleted or numbered list

Topic B: Tab stops

» Types of tab stops
* Set tab stops

* Remove tab stops

Topic C: Tables, columns, and breaks

» Insert a table
» Create and remove columns
* Insert page breaks

» Insert section breaks

Unit 10 Self-test
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Topic A: Headers, footers, page numbers, and bullets

Create a Header

Header — a section of information that appears at the top margin of each page of a document.

AutoSave (@ off) D1 = Document! - Word Header & Footer Tools  [ESIsll] &3]

File Home Insert Design Layout References Mailings Review View Help Design 2 Search 1
[® Header ~ f{ Eﬁl Quick Parts ~ |:| [Z! Previous [ Different First Page =125em

Footer ~ ® = Picts T3 Mext [ Different Odd & Even Pages ;‘ 1.25em .

@ Date & Document B Pictures Go to E‘_) = 5 p— Close Header
@ Page Number ~ Time Info~ [Fg Online Pictures Footer |_—| Show Document Text H and Footer

Header & Footer Insert Mavigation Options Position Close ~
L |-2-|-1.-|-E-l-1-|-2-|-J‘l-4-|-5-|-6-|-?-|-8_~|_|-9-|-10-|-11-|-12-|-13-|-14-|-15-|-16-&-1.?-|-1.8-|-].9 -
-
- Key Concepts of Computers | Page 1

! [Resaer [

Method 1

1. Double-click anywhere on the top of a page. A straight line (or a dashed line) on the head
will appear.

2. Enter any desired information on the header (such as a chapter title, a document tile, a
business logo, the creation date, etc.).

3. Double-click on the body of page (or press the Esc key) to close the header. The header will
be on the top of each page.

Method 2

1. Click the Insert tab.
2. Click the Header command.

AutoSave B ® v = Section 2 - Unit 10 &8 - Last Modified: 25 May O Search e = -

File Home @ Draw Design Layout References Mailings Review View Help Acrobat 12 Share I Comments

Shapes v & SmartArt Ty Header v IR REER RS -

B @ o Oshap [Q  Hfcetaddins \V Y i ) (g D 2 Q |

5 Icons i chart - e —4 4. a e

Pages | Table | Pictures = Add from 9 ’ Wikipedia | Online | Links | Comment Text - Symbols | Insert

v 2 « (23D Models ~ {g}Screenshot ¥ Filesv | O MyAdd-ins ~ Video v [ Page Numberv | go, v AZ- 8] ~ o Vi

Tables Illustrations Content Add-ins Media Comments Header & Footer Text Media

In the menu that appears, choose a desired header layout (called content control).
4. Enter any desired information on the header.

5. Double-click on the body of page (or press the Esc key) to close the header. The header will
be on the top of each page.
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Create a Footer

Footer — a section of information that appears at the bottom margin of each page of a document.

CONSETYALION O €NCrgy. 1L NS Iaw SLEs Al Cnergy may Wwansiorm Irom one 1orm 1nww
another, but is never lost. Joule 's law was named after him and states that heat will be
produced in an electrical conductor.

The majority of the laws and units of measurement stated above will be used in the later chapters of this book,

A footer

e
Being familiar with them will be beneficial for further study of electric circuits. /..--"'

AT

Method 1

1. Double-click anywhere at the bottom of the page. A straight line (or dashed line) on the
footer will appear.

2. Enter any desired information on the footer (such as the page number, author’s name,
copyright, references, etc.).

3. Double-click on the body of page (or press the Esc key) to close the footer. The footer will be
at the bottom of each page.

Method 2

1. Click the Insert tab.

Hame m Design Layout References Mailings Review View Help Q Tell e what you want te do

. 1 ) oy G o+ . - I3 ; =
Cover Page "— ) Pictures 27 leons 1l Chart B Get Add-ins Cd oo Link i Header A | Quick Parts
Blank Page ' & Online Pictures (7 30 Models ~ a4 Screenshot - ™ Bockmark ) . A WordArt -
Table = 3 My Add-ing = Online - Comment Text
Page Break - Shapes - ) SmartAnt S, Video Lo Cross-ieference *] Page Number=  pay -
Pages Tables llustrations Add-ins Media Links Comments Header & Footer Tea

Click the Footer command.
In the menu that appears, choose a desired footer layout.

Enter any desired information on the footer. The footer will be at the bottom of each page.

A

Double-click on the body of page (or press the Esc key) to close the footer.
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[™ Header ~ v [Z ~ | TlEquation ~
@ Footer ~ -r,.”. "4 = @ Q Symbol ~

Built-in -

Blank

[Type hem:|

Blank (Three Columns)

Ty here] iipe hee] [Ty here]

Austin

Banded

Page Numbers

Page numbers — Word supports automatically adding page numbers in a multi-page document.
Insert page numbers

1. Click the Insert tab.
2. Click the Page Number command.

Home Insert Design Layout References Mailings Review View

{; Tell me what you want to do

lover Page- [ 52 Pictures = leans 1l Chart B Getbddins | [ o &, Link = " Header = a=| [El Quick Parts-

Hank Page : " [ Online Pictures D) 30 Models = &, Screenshat - LA
Table

O - |* Boakmark ¢ [ Foater - .T " 4 WordArt -
- ’ u - nline . omment [ et
‘age Break = L& Shapes - 4[] SmartArt 3 My Add-ins Videg o Cress-reference Box -

3. Select a desired position (such as Top of s tumber s rr—
Page, Bottom of Page, etc.) you wish the
page number to appear in.

4. Select a desired style (such as Plain p— f';ag,:‘ pr o
Numbers 1, Plain Numbers 2, etc.).

-

Plain Number 3
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E Top of Page »
@ Bottom of Page by
Page Margins >
@ Current Position #
@’ Format Page Mumbers...
E‘;’{ Bernove Page Mumbers

Change the starting page number

1. Click the Insert tab. Number format:  ERENEENENE
. Page Text ick W
2. Click the Page Number ’ igh-er 1 Box- Eu'c _ Dr: [] Include chapter number
command. — = arts
Top of Paqge b Chapter starts with style: | Headin
3. Select Format Page 8 Top ’ . =
Numbers. [z] Bottom of Page 4 S -
Examples 1.1, 1.4
4. Click Start at and type the ] Page Margins g A—
page number you wish to [#] Current Position ’ . . -
appear on the first page. {_) Continue from prtwfus section
) Ry |Format Page Numbers... @ startat 114 =
5. Click OK.

[% Remove Page Numbers oK 1

Start page number on page two
(hide the page number on the first page)

1. Click Layout.
2. Click the Page Setup Dialog box launcher.

Home Insert Design References Mailings Review View

Oirientation = #— Breaks - Indent Spacing

Size - [ Tline Numbers = 3 Left: 0" > 1= Before: 0 pt -

Columns =  p2 Hyphenation - «Right: 0" : i After: O pt : i Selection Pane
Page Setup m Paragraph . Arrange

3. Select Layout tab and Check the box next to Different first page.
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Page Setup

Margins Paper Layout I
Section
Section start: New page | w |

Suppress endnotes

Headers and footers
|:| Different odd and even
I|:| Different first page I

4. The page number will disappear from the first page.

Bulleted or Numbered Lists

Bullet — a dot, a small circle, diamond, or other symbols that is found before the text (a phrase,
sentence or paragraph, etc.) to help organize information, make it easier to read, or differentiate

between the different points.

I=xiS-Er ==zl T asBbCd
Bullet Library

None Y (@) | - 0:0
> Vv
Document Bullets

| . |

Insert a bulleted list (a list whose items are bulleted)

1. Select the text you wish to format as a list.

2. Click the Bullets icon.
“ Home Insert Design Layout References Mailings Rewview View Help Q Tell me

=l S
- = h= 1= A

TimesMewR =12 -~ A" A Aa- fpliz=-i=-"z- ¢=2= 4| Y | AaBbCol| AaBbCel AaBbC

Paste w BT U-~abex, x’ A-¥-A- EE== = b0 - 1 Nermal | 1Mo Spac...  Heading 1

Clipboard Fant v Paragraph Styles
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3. Click to select a bullet symbol (i.e., a dot, a small circle, diamond) that you wish to use for
the bullet.

4. Deselect the text.
Insert a numbered list (a list whose items are numbered or lettered)

1. Select the text you wish to format as a list.
2. Click the Numbering icon.
“ Home Insert Design Layout References Mailings Review View Help 4/ Tell me
L - - - 1 i ~ ey
Times NewR~[12 - A A" Aa- & i=Ai=-[=- 2= 3| AaBbCcl AaBbCel AzBbCe
A-W-A. =E=E== = &- - 1 Mormal | 1Mo Spac... Heading 1
I Paragraph Styles

B I U ~akex, ¥
Fant

F‘as.te .
= »
Clipboard
3. Click to select a number or letter symbol that you wish to use for the list.

Mumbering Library

(a).
Mone (b). 2
(c). 3.
1) l. A
2) Il B.
3) M. C.
a) a. i.
b) b. ii
c) C. iii.

Document Number Formats

1.
-
L

4. Deselect the text.
When you delete or add items in the list, or change the numbering format of the style, the numbers /

letters in a list are updated automatically.



Topic B: Tab stops

Tab stop — a location where the cursor (insertion point) would stop when the Tab key is pressed.

+ Tab stops are used to allow users to align text at a specific location in a document.

+ A Tab stop defines length of Indent used at beginning of a line or paragraph.

=

If you are looking for a quick exam, homework guide, and review book in Computer Studies, “Key
Concepts of Computer™ is an excellent source. Skip the lengthy and distracting books and instead
use this concise book as a guideline for your studies, quick reviewing and tutoring.

This unique and well-structured book is an excellent supplement and convenient reference
book for fundamental / intermediate computer studies. [t provides concise, understandable and
effective guide on fundamental / intermediate level computer.

* Pressing the Tab key (on the keyboard) will move the cursor to Tab "
—

the next tab stop (which itself is invisible).

» The tab stop appears on the horizontal ruler at the top of the
Word window.

Types of Tab Stops

+ Left Tab — text is aligned to the left of the tab stop.

* Center Tab — text is centered in the middle of the tab stop.

» Right Tab — text is aligned to the right of the tab stop.

* Decimal Tab — numbers are aligned by their decimal points.

» Bar Tab — inserts a vertical line (bar) into a line of text.

Styles
'L"'i"""'l.g" 3'_|"J_E"$
8 A 4 A A
) | i |
, \
1 |
'-Ill |II | | .Il
Left tab Center tab Right tab Decimal tab Bar tab
Apples 4l $1.201b $4.80
Oranges 10 1k $1.40/k $140
Peaches 100 Ib $1.50/1b $150.00 |
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Set Tab Stops

The tab selector (tab indicator) — a small button located in the left corner of the horizontal ruler that
supplies the user with a variety of tab marker (tab stop) options (left, right, center, etc.).

Insert Design Layout References Maili

F

B U= B QP @

Cover Blank Page Table Pictures Online Shapes Icons 3D S

Page~ Page Break v Pictures - Models ~
Pages Tables Illustrations

[

Insert a tab stop

Method 1

1. Select the paragraphs / sentences you wish to set tab.
2. Click the Tab Selector until it displays the type of tab stop you wish to use.

3. Click on the lower edge of the horizontal — [FITSEEGEEEIEESNFETIRTREN PV view  JEET

ruler at the exact spot where you wish the =58 M5 5 OneP:
tab to set. (If you don’t see the ruler atthe & | &5 e O\ L oo muttip
top of the Word window, click View, then  Vestical Side o Zoom 100% _
. . to Side [] Navigation Pane e Page V
Ruler to display it.)
Page Movement Show Zoom

4. Click to place the insertion point in front I - | PH I A
of the text where you wish to insert the
tab.

5. Press the Tab key on the keyboard.

Method 2

1. Select the paragraphs / sentences you wish to set tab.



Topic B: Tab stops | 177

Spacing
Before: opt = Li
After: opt =

[] bon‘t add spage between paragr

Preview

¥ ik iy Fimapaapl o sdimg lemy, S meboy mal st

2. Click the Paragraph dialog box launcher and select the Tabs.

| Home Insert Design Layout References Mailings

Times New R~ 12 = A‘ A- Aa- %“ E "‘:‘ = I". = E E %J. q
BIU-dex,x A-¥-A-B===1=-5-1-
Font F Paragraph E

3. In the “Tab stop position” box, enter the measurement (such as 4”) on the horizontal ruler
where you wish the tab to appear.

4. Under “Alignment”, select a tab stop type (such as Left, Center, Right, Decimal, etc.).

Tabs t x

Iab flap position [I-I‘Iaull tab tops:
| 0.5 5

Tab stops to be cleared:

Alignment
®) Lett () Center O Bight |
() pecimal () Bar

Leader
®) 1 Hone e =
Oa__

Set Clear Clesr &1

5. Click OK.
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Remove Tab Stops

Method 1

1. Select the paragraphs you wish to remove the tab.

2. Drag the tab stop marker off the horizontal ruler.

Method 2

1. Select the paragraphs / sentences you wish to remove the tab.

2. Click the Paragraph dialog box launcher.

| Home Insert Design Layout References Mailings Reviey
Times NewR <12 = A A Aa~ B i=~i=-'i—~ €3= 8|
B I U-abex, X’ A-%-A- ==: =- &
Font r Paragraph E

3. Click to select the Tabs.
4. Click Clear All.

-

Before: 0pt = Li Tab stop position: Default tab stops:
| 0.5 =

After: opt |5
Tab stops to be cleared:
[] bon't add spage between paragr

Preview Alignment
(®) Left (O Center ) pight
e Pt d kg oo st s Opeamal O par
Leader
® 1 None O2 e O3
Oa__
set Ciear

5. Click Ok. Set As Default Cancel
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Insert a Table

Table — information arranged in a condensed form of columns and rows. It is a more effective way to
present information.

Insert a table in a document (Word 2016)

Method 1

1. Click where you wish to insert the table in your document.

2. Click the Insert tab and the Table button.

File Home m Design La

B Cover Page -~ === Lo Pictures

_H] Elank Page Tab |__'g Online Pictures
able i
"— Page Break - L&y Shapes -
Pages Tables

3. Drag through to select the desired number of rows and columns (a table will appear).

Insert Design Layout

P Pictures ¥ lcc
F& Online Pictures £ 3D
Ta‘l:jle Eﬂhapes* = 5n
8x4 Table ;
LI
LI
LI
LI
N I
N [ O [
N [ [

Method 2

1. Click where you wish to create the table in your document.
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2. Click the Insert tab. _mm Design  Layout
3. Click the Table button. D [} Pictures % Icon Up or down arrows
4. Click Insert Table. = L& Online Pictures €2 3D M
able oy . - Insert Takle 7 b4
5. Click the up or down B | < Shepes [15ma . \
arrows (in the Table drop- fxd Table A | Table size —
down menu) to select the [JC | || | Neumber of sohumns: & <
desired number of columns. 1 BB Number of rows: : -
6. Click the up or down 00 | e :
arrows to select the desired || JLILIIILICICICIC] ||| @ Fxed coumn width: | auto =
number of rows. O0O0000000; () AutoFit to contents
. _ OOO000O00C0CC | © auterit to wingow
7. Click OK to insert the OO O0O000000
table. B3| insert Table... [] Remember dimensions far new tables
™ Draw Table Cancel

Create and Remove
Columns

Add columns to a document

1. Select the paragraphs you wish to lay out in columns.

2. Click the Layout tab and click the Columns button.

Home Insert Design References Maili

H ||:' s Orientation = *— Breaks ~ Indent Spacing

[ Size = [ ILine Numbers = 3 Left: 032" - I Befc

~ Columns ~ | b2 Hyphenation ~ «Right: 0" = %= A fte

Margins|
- L

Page Setup [ Paraqraph

3. Click to select the number of columns you wish to create (such as “Two,” in the drop-down
menu).

4. The text will lay out in columns.

== Left

=: Right

More Columns...
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Remove columns
1. Click anywhere in the columns. T =
: ne
2. Click the Layout tab. |
3. Click the Columns button. == Two
4. Click One to change the document as one column. = m
=== ree
Insert Page Breaks —
Right
Page break — a page break marks the end of a page that indicates where the
printer will start a new page. b O

This unique and well-structured book 15 an excellent supplement and convenient reference book
for fundamental /-intermediate computer studies. It provides concise, understandable and effective
guide on fundamental / intermediate level computer.

Page Break

Insert a page break

1. Click where you wish a new page to begin.
2. Click the Insert tab.
3. Click the Page Break button. A page break is inserted in the document.

File Homa Insart Dasign Layout Raferances Mailings

n Lo Pictures £ leons il S e m
- . [t
aOnline Pictures [f) 3D Models = 5. "
Flgl‘i Tabla Shapes = ™ Add- Online Links
. = o es ins = Video -
Tables llustrations Bledha
E ! ige break — a page break marks the end of a page

Cover Blank | Page [y, page.
Page = Page | Break

Pages This unbmue and well-struchared book i an exee

4. Click on the Home tab and then Show/Hide symbol () will show hidden page beaks (click

the Show/Hide symbol again will remove ).
Insert Dasign Layout References Mailings Rorviow Wiew Help &/ Tellme

Times Mew R =12 - A i'-'l.. Aa- ‘?‘f . i v lic v | #E # -%' AaBbCel AaBbCel ."'"I.L][_)}t]t-.[
Paste " B I U ~abeXx X .-j-_..-ﬂ?.&. :

I w T Mormal | T No Spax Heading 1

=

Clipboard = Famt . Paragraph . Styles
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Insert Section Breaks

Section break — a section break splits a page into sections that can have a different format or layout
within the same page in the document.

If you are looking fora quick exam, homework guide, and review book in Computer Studies, “Key
Concepts -of Computer” is an-excellent source. Skip the lengthy and distracting books and instead

use this concise book as a guideline for your studies, quick reviewing and tutoring.

This unique- and well-structured -book is-an-excellent supplement and convenient
reference book for fundamental / intermediate computer studies. It provides concise,
understandable and-effective guide on fundamental / intermediate level computer.

Insert a section break w  Design References Mailings
. Indent Spacing
Click where you wish a new section to begin. Page Breaks

Page
Mark the point at which one page ends
and the next page begins.

1

2. Click the Layout tab. ;
3. Click the Breaks button.
4

-

Column
Indicate that the text following the column
break will begin in the next column.

Click to select the type of section break you wish to

use.
3 X — Text Wrapping
5. Click on the Home tab and then Show/Hide symbol OE|  Separate text around objects on web
(1‘[) Wlll ShOW hldden section beaks. — pages, such as caption text from body text.
Section Breaks
Remove a page or section break J=| Mexthage
= Insert a section break and start the new
== section on the next page.
1. Click the Home tab. — - -
. . . . g Insert a section break and start the new
2. Click the Show/Hide symbol q (to display the section —|  section on the same page.
break)' —2=| EvenPage
. . . = Insert a section break and start th
3. Double-click the page or section break to select it. | —— t;,‘;“neiil\,iﬂ-nifnber;"zl“ge_ -
4. Press the Delete key (on the keyboard).

File Insert Design Layout References Mailings Review View Help

Times NewR <12 -~ A A Aa- /fp =~ =~ |52 %., AaBbCel AaBbCel AgBhC

- T Mormal | TMo Spac.. Heading 1

Paste o B 7 U-aex x 'i';"-"*y'ﬂ'

Clipboard = Font . Paragraph . Styles
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Media Attributions

+ Insert tab screenshot © Microsoft. Used with permission.


https://www.microsoft.com/en-us/legal/intellectualproperty/permissions/default




Unit 10: Self-test

Find answers to this self-test at the back of the book: Answers for Self-Tests

True or false

ook W

The footer is a section of information that appears at the bottom margin of each page of a
document.

Word does not support automatic numbering of pages in a multi-page document.
Right Tab — text is aligned to the right of the tab stop.
Decimal Tab — numbers are aligned by their vertical bar.

Click on the Insert tab and then Show/Hide symbol (1) will show hidden page beaks.

Fill in the blank

A [blank] is a section of information that appears at the top margin of each page of a
document.

The [blank] is a dot, an asterisk, a small circle, or other symbols that is found before the text
to help organize information, make it easier to read, or differentiate between the different
points.

Bar Tab — inserts a [blank] line into a line of text.

A [blank] break splits a page into sections that can have a different format or layout within
the same page in the document.

Multiple choice

10.

[Blank]-click refers to quickly click the left mouse button twice on any folder, file, or
program to open it.

a. right
b. double

c. left

d. all of the above
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11. Tab stop — a location where the cursor would stop when the [blank] key is pressed.
a. shift
b. return
c. tab
d. all of the above

12. Center Tab — text is centered in the [blank] of the tab stop.
a. left
b. right
c. bar
d. middle

13. A [blank] break marks the end of a page that indicates where the printer will start a new page.
a. section
b. page
Cc. text
d. all of the above

14. Right Tab — text is aligned to the [blank] of the tab stop.
a. left
b. middle
c. bar
d. right

15. Decimal Tab — numbers are aligned by their [blank].
a. decimal points

b. tab stop

c. bar

L

all of the above



Unit 11. More on electronic communication

Topic A: Web browser

* Web browser / bookmark

 Safari

» Show / hide the bookmark bar in Safari
* Mozilla Firefox

* Show / hide the bookmark bar in Firefox

Topic B: Email

* Email address

* Create an email account

* Sending and receiving email
* Email folders

* Email attachment

Topic C: Web search engine

» Perform a search using a web search engine
* Security issues on the internet

 Prevent cyber threats

Unit 11 Self-test
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Topic A. Web browser

Web Browser / Bookmark

Browser

* Browser — a software program that allows users to access and display websites or webpages
(documents, images, video, music, etc.) on the internet.

* Some popular web browsers:

‘.
° Google Chrome

° Q’ Mozilla Firefox
e

o Internet Explorer

> Safari

° O Opera

Bookmark

» Bookmark (or favorite) — a collection of links (a saved shortcut) to web pages that is stored
in a web browser. Saving bookmarks allows users to quickly navigate back to the websites
they visit the most.

o

m e
v Favorites

e Web files access

@) CBC Listen | Radio One | Toronto

& Prince George Citizen

e College

e~ F#EEER -- Creaders.NET, BBSLAND.com

* Bookmark bar - it contains all bookmarks that shows on the top of the Window (under the

189
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address bar).
Bookmarks Window Help MEB YD = Fla
ﬁD (C) i bookmark bar &
Web files access CBC Listen | ...ne | Toronto Prince George Citizen _College Hﬁi:ﬂ——\AND.cum
Boo. Ik bar Address bar
Safari
Add bookmarks to Safari
3 05 u =
* Open Safari. Double-click on Safari to open it. & oo Add to Reading List
+ Go to the website you would like to bookmark. | ™ Add Bmkmarbﬂ

& Email This Page

I'T_‘I € Messages

* Click the Share button to the upper-right corner.

* Click Add Bookmark from the pop-up menu that @) AirDrop
appears. €2 Twitter
» Choose where to store the bookmark from the pop-up menu  f] F_aﬂﬂbmk
(Favorite or a folder). @ Linkedin
. ) More...
* Click Add.
Add this page to:

Mis. B

College of New Caledonia | CNC

cancol (D

Find a bookmark in Safari

* Open Safari. >
* Click the Bookmarks on the top of the Window.

@ Safari File Edit View History |Bookmarks | Window Help

]o.c in d e
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* Select Show Favorites from the pop-up menu that appears.

ELNIAOEREE Window  Help

Show Favorites
Show Frequently Visited in Favorites

Show Bookmarks
Edit Bookmarks B

Add Bookmark... 3ED
Add Bookmarks for These 4 Tabs...
Add Bookmark Folder

 Find and click a bookmark to open it. Or click on the Sidebar icon to the upper left-corner (in
the Safari toolbar) to open a bookmark.

i Safari File Edit View History Bookmar

o0 e < i 1<

Show / Hide the Bookmark Bar in Safari

Show or hide the bookmark bar in Safari

* Open Safari. >
* Click the View menu on the top of the Window.

& Safari File Edit | View| History Bookmarks Window Help

Jeoe « in 0° @

* Select Show (or Hide) Favorites Bar from the pop-up menu that appears depending on
whether the bar is on or off. Click Show Favorites Bar to turn the bookmarks bar on. Click
Hide Favorites Bar to turn the bookmarks bar off.
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History Bookmarks Window

Customize Toolbar...

Show Favorites Bar

Show Status Bar

Show Sidebar

Show Bookmarks Sidebar
Show Reading List Sidebar
Show Shared Links Sidebar

Show All Tabs

Mozilla Firefox

Add bookmarks to Firefox

A e

Open Firefox. Q‘

{+¥B

#/

{r3L
~31
~3e2
~apq

{38\

Double-click on Firefox to open it.

Go to the website you would like to bookmark.
Click on the star icon to the right of the address bar.
Click Done to add the bookmark.

Find a bookmark in Firefox

Open Firefox.

Type the first word of your bookmark in address bar.
As you type in address bar, Firefox will suggest

websites (bookmark) you’ve visited.

Find and click a bookmark to open it (to see your

favorites).

A History Bookmarks Window

Customize Toolbar...

Hide Favorites Bar 3B
Show Status Bar a8/
Show Sidebar 0 38L
Show Bookmarks Sidebar ~ 381
Show Reading List Sidebar ~2
Show Shared Links Sidebar ~33
Show All Tabs 1 36\

Let's baild a bridgs

to your lature

st
—

C ——

MName:

Edit This Bookmark

.o Ellil

‘ollege of New Caledonia | C

Folder:

£ Other Bookmarks v v
Tags:

Separate ta ith comma w
[ Show editor when saving

“ Etmm aankmalk
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—— Address bar

= c o || Q, col *____]

® col — Search with Google

Q, college of new caledonia

Q, coles

O\ colby covington

Q, colony granville
*l &% College of New Caledonia | CNC ~|» https://enc.be.ca

Q, cole sprouse

Show or hide the bookmark bar in Firefox

1. Open Firefox. Q’

2. Click on the three-line icon to the upper-right corner.

= ih @ & | =

3. Click Library on the pop-out menu.

g I O &

£ Signinto Sync

@ Content Blocking Standard
B2 New Window CtrlsN
&2 Mew Private Window Ctrl=Shift=P

ﬁ Restore Previous Session

foom - 100% + e
Edit X &b @
W\ Library )

w0 Logins and Passwords

4. Click Bookmarks on the pop-up Library menu.
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14 Library

* Bookmarks
) View Pocket List
@ History

i Downloads

5. Click the Bookmarking Tools on the pop-up Bookmarks menu.

< Bookmarks

ﬁ Bookmark This Page
/& Bookmarking Tools
Q Search Bookmarks

Recently Bookmarked

6. Click the View or Hide Bookmarks Toolbar in the Bookmarking Tools menu to turn the
bookmarks bar on and off.

< Bookmarking Tools

E Add Bookmarks Menu to Toolbar
GD View Bookmarks Sidebar
(®) Hide Bookmarks Toolbar




Topic B. Email

Email Address

* Email (electronic mail) — an Internet service that allows users who have an e-mail account
(address) to send and receive messages anywhere in the world.

> An email may contain attachments (files, photos, videos, etc.).

> Some free email accounts and service providers: Gmail, AOL Mail, Outlook.com,
Zoho Mail, com, Yahoo Mail, ProtonMail, Yandex Mail, GMX Mail, etc.
Here is wour e-mail icon;

I Gmail .com|

* An email address consists of three parts:
o User name of the recipient.
° (@ sign (at sign) — every email address consists of an @ sign.

> Domain (email service provider — an organization / company, or a website name).
Example: a) username(@gmail.com

Domain (website name)

b) transcripts(@unbc.ca

. :

Usei‘ name Domain (UNBC)

Popular Free Email Providers

Email provider Sample email addresses
Gmail username@gmail.com
Outlook username@outlook.com
Yahoo! Mail username@yahoo.com
ProtonMail username@protonmail.com
Zoho username@zoho.com

AOL username(@aol.com
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Create an Email Account

Create a Gmail account

1. On your computer, go to the Google Account creation page.

e < > @ GD ] = Create 8 Gmail account
Wb Slos mccess  CBOC Listen | .00 | Toranio  Prince Gecege Citiess  College &R - .. SLAND. com
Mail = wangm@ono. be.ca GG Soarch Create |
GD glE Create a Gmail account Q.
oA E Mews [] videos 7 Shopping  [&] Images : Moare Settings  Tools

About 1,300,000,000 results (0.77 seconds)

Create a Gmail account - Gmail Help - Google Support

https://support.google.com/maillanswer/56256 7hi=en
You can use the usemame and password to sign in to Gmail and other Google products like

2. Enter your first, last name, username, and password (twice).

3. Click Next.
Create your Google Account

to continue to Gmail

First name Last name

Username @gmail.com

You can use letters, numbers & periods

Password Confirm @

Use 8 or more characters with a mix of letters, numbers &
symbels

Sign in instead

Enter your phone number (optional).

Enter “Recovery email address” (optional).
Enter your birthday, and gender.

Click Next.

N o ok


https://accounts.google.com/SignUp
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8. Scroll down and click I agree. Your account will be created and ready to send and receive
emails.

[ Phone number (optional)

i+l A

We'll use your number for account security. It won't be visible to
others.

Recovery email address (optional)

We'll use it to keep your account secure
Month v Day Year
Your birthday

Gender -

Why we ask for this information

Sending and Receiving Email

M Gmail

Steps for sending and receiving emails

1. Log into your email account (such as Gmail, Outlook, I_ Compose
Yahoo! Mail, etc.). Or log into your institutional email
(many colleges / universities give students an email address).

2. Click Compose (Gmail) or something similar (e.g., New in  &J Inbox
Outlook).
W Starred
3. Enter a recipient’s email address in the “To” field. (You can
also add recipients in the “Cc” and “Bcc” ©® Snoozed
fields.)
> Sent

4. Enter a subject (the topic or heading of your email).
5. Type your message in the main body field.
6. Click Send at the bottom of the page.
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New Message - @ X

|“A®c—3©&)839 |

CcandBcc

* Cc (carbon or courtesy copy) — entering a person’s email address in the “Cc” field means
that person will receive a copy of the email (for their information).

* Bcc (blind carbon copy) — Bcc is similar to that of Cc except that the email address is
invisible to the people in the “To” or “Cc” fields. Use Bcc if you don’t want the other people
to see who else has received a copy of the email.

Email Folders

+ Inbox folder — the place where incoming emails are e

received and stored (incoming emails arrive in the “Inbox”

folder). Drafts 31
+ Sent Mail folder — the email you’ve sent will be saved in Sent Items

the “Sent Mail” (or “Sent Items™) folder. Deleted [tems 58
 Drafts folder — an unfinished email will be automatically Archive

saved to your ‘Drafts’ folder.

* Junk Email folder — the Junk Email Filter feature moves suspected incoming emails (spams)
to the Junk Email folder (a place used to store spam emails).

* Deleted items folder: every email that you deleted will be moved to the “Deleted Items”
folder.

o It’s a good idea to empty your “Deleted Items” folder from time to time in order to
save space.

o To empty the Deleted Items folder: Right-click the Deleted Items folder and click
Empty, then Ok.



Inbox

Drafts

Sent Items

Deleted Items

Archi
v Book
v one
v Famil

Junk
v Mis

Note

RSS |

Email Attachment

31

58

Create new subfolder

Empty folder

Add to Favourites

Recover deleted items...

Mark all as read

Permissions...

Steps to send emails including attachments

8.
9.

o Uk W=

Log into your email account.

Topic B. Email | 199

Empty folder

Are you sure you want to permanently delete all the
items and subfolders in Deleted Items?

Click Compeose (Gmail) or something similar (e.g., New in Outlook).

Enter a recipient’s email address in the “To” field.

Enter a subject.

Type your message in the main body field.

Click Attach or something similar (e.g., the paper click icon).

B Send I MJ Attach ™~ I ]E Discard

All|leo ©@ 2 M D N |

Select the file you want to attach from your computer’s folder.

Click the Open or another similar button to attach the file to your email.

Click Send at the bottom of the page.

Media Attributions

* Google-birthday-e1600562003765






Topic C: Web search engine

Perform a Search using a Web Search Engine

Search engine — an Internet search engine is a web-based tool (a software) that is designed to search
the content of web pages and to find particular information on the Internet.

Some popular search engines

* Google
* Bing
* Baidu
* Yahoo!

* Yandex

* Ask.com
* DuckDuckGo

Search the Internet using a web search engine

1. Open a search engine in a web browser (such as Google in Chrome).

2. Type a few specific keywords or phrases to describe whatever you wish to search in the
search bar. Search engines look for the keywords in your query.

3. Press the Enter key on the keyboard.

4. Repeat above steps if necessary.

Search bar

P

Google

H
]
N

201
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Security Issues on the Internet

Internet security issues

Although Internet led to many benefits, it also poses a greater potential for security threats.

The common Internet security issues

» Hacker — refers to a person who can gain unauthorized access (break into) to a computer or a
network to commit crimes.

» Some things a skilled hacker can do to your computer:
o Hijack your usernames and passwords;

o Gain access to the personal information (credit card numbers, bank account, social
insurance number, etc.);

o Steal, change, exploit, sell or destroy data;
o Damage or bring down systems;
o Hold those system hostages to collect ransom.

» Malware (short for malicious software) — a software that is designed to damage, disrupt, or
infect computers.

o Malware can gain unauthorized access to a computer and continuously run in the
background without owner’s knowledge.

o Malware is a single term that refers to all the different types of threats to your
computer safety such as virus, Trojan horse, worm, spyware, etc.

» Computer virus — a specific type of malware that is designed to replicate (copy) and spread
from one computer to another.

o A virus can make a copy of itself over and over again.

o A virus can spread from one computer to another through email, removable storage
devices, networks (e.g. internet messaging services, download infected files ...),
etc.

o A virus can damage your computer by corrupting system files, sending spam,
stealing data and personal information from your computer, destroying data,
deleting everything on your hard drive, etc.

» Trojan horse(or Trojan) — a type of malware that looks harmless but can damage, disrupt,
steal data on your computer.

o A Trojan misleads users of its true intent.

o A Trojan may claim to get rid of your computer viruses but instead introduces
viruses onto your computer.

o A Trojan can take the form of an innocent-looking email attachment, download,
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etc.

* Worm — it is similar to a virus (a sub-class of a virus). It is designed to quickly self-replicate
and spread copies of themselves from one computer to another.

o The key difference between a virus and a worm is that a virus needs human action
to replicate, whereas, a worm doesn’t.

o A virus only spreads when a user opens an affected file whereas a worm spreads
without the use of a host file.

 Phishing — a scammer uses deceptive emails or websites and tries to obtain valuable personal
information (i.e., username, password, account number, etc.).

o Phishing is a common online scam used by cyber criminals.

o A scammer may use a deceptive email or website appearing to represent a
legitimate firm.

* Spyware — a software that secretly monitors (spies) user’s
online behavior and gets sensitive information about a
person or organization without the user’s knowledge.

o A spyware can record a user’s Web browsing
habits, e-mail messages, keystrokes on online
advertisements, personal information, etc., and

y / /
forward it to a third party. (77

o Advertisers can use spyware to target specific advertisements to your tastes.

o Criminal organizations can use spyware to collect financial information (banking
accounts, credit card information, password, etc.).

Prevent Cyber Threats

Tips on how to prevent malware from infecting your computer

+ Backup files and store in different locations.

« Don’t open any suspicious / unknown emails or the websites. The second part (the part after
the @ ) of an email / website address should represent the company that owns the email /
website (domain).

Example: registrarsoffice(@cnc.bc.ca

#

Domain (College of New Caledonia)

* Don’t download an unknown or a suspicious attachment (document, picture, music, game,
video, etc.).

* Do not call fake tech support numbers (tech support scams). If you get pop-up window from
fake companies offering to help you with a malware infection, don’t call the number.

» Use a secure and strong password (unique, hard to guess, etc.).
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* Install anti-malware / virus software (keep it up to date).

* Scan with antivirus software on a regular basis.

Some free antivirus software:

* Comodo Free Antivirus
¢ AVAST Free Antivirus
 AVG Antivirus Free

e Avira Antivirus

» Bitdefender Antivirus Free



Unit 11: Self-test

Find answers to this self-test at the back of the book: Answers for Self-Tests

True or false

A bookmark is a software program that allows users to access and display websites or
webpages on the internet.

A web browser is a collection of links to web pages that is stored in a bookmark.

3. An email may contain attachments (files, photos, videos, etc.).

Bcc is similar to that of Ccexcept that the email address is invisible to the people in
the “To” or “Cc” fields.

An unfinished email will be automatically saved to your ‘Income’ folder.

Although the Internet led to many benefits, it also poses a greater potential for security
threats.

Malware is a single term that refers to all the different types of threats to your
computer safety such as virus, Trojan horse, worm, spyware, etc.

Fill in the blank

10.
11.

12.

13.
14.

15.

16.
17.

18.

Saving [Blank] allows users to quickly navigate back to the websites they visit the most.
A bookmark [Blank] contains all bookmarks that shows on the top of the Window.
Click on the [Blank] icon to the right of the address bar can add the bookmark to Firefox.

Email — an Internet service that allows users who have an [Blank] account to send and
receive messages anywhere in the world.

Enter a person’s email address to the [Blank] field means that person will receive a copy of
the email.

The email you’ve [Blank] will be saved in the Sent Mail (or Sent Item) folder.

An internet [Blank] is a web-based tool that is designed to search the content of web pages
and to find particular information on the Internet.

A [Blank] refers to a person who can gain unauthorized access to a computer or a network to
commit crimes.

[Blank] is a software that is designed to damage, disrupt, or infect computers.

A computer [Blank] is a specific type of malware that is designed to replicate and spread
from one computer to another.

Advertisers can use [Blank] to target specific advertisements to your tastes.
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Multiple choice

19. Click the [Blank] Bookmarks Toolbar in the Bookmarking Tools menu to turn the bookmarks
bar on and off.

a. On/ Off

b. Open / Close

c. View /Hide

d. All of the above
20. An email address consists of:

a. @ sign

b. username

c. domain

d. all of the above
21. Incoming emails arrive in the [Blank] folder.

a. Sent Mail

b. Inbox

c. Drafts

d. Junk Email

22. [Blank] is a type of malware that looks harmless but can damage, disrupt, steal data on your
computer.

a. phishing
b. spyware

c. aTrojan horse

.

d worm



Glossary

application program (or application software)
a computer program that provides users with tools to accomplish a specific task.
artificial intelligence (AI)

an area of computer science that deals with the simulation and creation of intelligent machines or
intelligent behave in computers (they think, learn, work, and react like humans).

basic file management
a way to name, save, backup, organize, and keep track of files and folders on a computer.
Bcc (blind carbon copy)

Bcc is similar to that of Cc except that the email address is invisible to the people in the “To” or
“Cc” fields. Use Bcc if you don't want the other people to see who else has received a copy of the
email.

bit

the smallest, most basic unit of measurement for computer data storage, represented as either a 0
or a 1. One byte is equal to 8 bits.

blog
a personal website or webpage that is like an online diary/journal.

bold

a typeface that makes a character thicker than the regular one. Boldfacing is often used for
emphasis, headings, subheads, highlight keywords, etc.

bookmark (or favourite)
a collection of links (a saved shortcut) to web pages that is stored in a web browser.

bookmark bar

a row of all bookmarks that shows on the top of a browser window (under the address bar).

207



208 | Meizhong Wang

browser

a software program that allows users to access and display websites or web pages (documents,
images, video, music, etc.) on the Internet.

bullet

a dot, a small circle, diamond, or other symbol that is found before the text in a list (a phrase,
sentence or paragraph, etc.) to help organize information, make it easier to read, or differentiate
between the different points.

byte
a unit of measurement for data storage. One byte is equal to 8 bits.
Cc (carbon copy or courtesy copy)

entering a person's email address in the “Cc” field means that person will receive a copy of the
email (for their information).

center-justification

text is aligned to neither the left side nor right.
chat room

an online service that allows people to communicate by typing messages to each other in real time.
computer monitor

a display screen used to display information (text, image, video, etc.) processed by a computer.
computer system

a complete computer that includes a system unit along with all its software (such as Office 2016,
Windows 10, etc.) and peripheral devices (such as a mouse, keyboard, monitor, printer, etc.)
connected to it.

computer virus

a specific type of malware that is designed to replicate (copy) and spread from one computer to
another.

cookie

A small text file stored in a user's computer by a website that the user has visited so that it can
remember something about the user at a later time.
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copy

make a duplicate of the selected items (text, symbol, table, image, etc.) and place it in another
location.

CPU (central processing unit)

The brain or engine of a computer, where most of the processing and operations take place.
cut

removes the selected item from its original position.
database program

a program that is designed for creating, editing, updating, and maintaining databases and
managing organized information stored in them.

deleted items
an email folder that saves all emails that have been deleted.
desktop computer

a personal computer that is designed to stay at one location and fits on or under a desk. It typically
has a monitor, keyboard, mouse, and a tower (system unit).

device driver

a software program that is designed to control a particular hardware device that is attached to a
computer.

disk drive
a computer device that stores and retrieves information, data, files, programs, etc., from a disk.
double-click
quickly click the left mouse button twice on any folder, file, or program to open it.
drafts
an email folder that automatically saves unfinished emails.
drag and drop

press and hold the left mouse button to grab an object (such as an icon on the desktop) and place it
to a different location.
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Editing a document

making revisions to a document, focusing on correcting errors, improving the accuracy of
language, rearranging, making words and sentences clearer, more effective, etc.

email

an Internet service that allows users who have an email account (or address) to send and receive
messages anywhere in the world.

external hardware devices (peripherals)
any hardware device that is located outside the computer.
file

a storage unit on a computer that stores information, data, etc. (such as a document, an image,
etc.).

filename

a unique name given to a file to identify it.
files hierarchy

a file system that organizes folders and files in a top-to-bottom structure.
firewall

a network security device designed to prevent unauthorized access to or from a network.
folder (or directory)

a virtual storage space used to store and organize computer files.
footer

a section of information that appears at the bottom margin of each page of a document.
formatting

the appearance of a document. It is the shape, size, form, style, typeface, general arrangement etc.
of a document.

FTP (File Transfer Protocol)

a set of rules (a protocol) for transferring files between computers over the Internet.
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hacker

a person who can gain unauthorized access to (break into) a computer or a network to commit
crimes.

hard disk drive
the main data storage device in a computer.
hardware

any physical device or equipment used in or with a computer system (anything you can see and
touch).

header
a section of information that appears at the top margin of each page of a document.
help menu / button

the user can click help button in Word to initiate a search, display the help resources, and aid the
user in his / her task.

horizontal scroll bar

a horizontal bar on the bottom of a window or screen that allows the user to scroll the window
viewing area to the left or right.

horizontal scrolling
sliding content left or right on a computer screen using a horizontal scroll bar.

HTTP

short for Hypertext Transfer Protocol. A set of rules (a protocol) for transferring and accessing
data using the web.

inbox

an email folder where incoming emails are received and stored.
input device

a piece of hardware device which is used to enter information to a computer for processing.
integrated circuit (IC)

a small electronic circuit printed on a chip (usually made of silicon) that contains many its own
circuit elements (e.g. transistors, diodes, resistors, etc.).
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internal hardware devices (or internal hardware components)
any piece of hardware device that is located inside the computer.
Internet
a globally connected massive computer network system.
IP (Internet Protocol)
a set of rules (a protocol) for sending data from one computer to another on the Internet.
ISP (Internet service provider)
a company that provides Internet service to customers.
italics

a type style with characters that slope to the right. Italic is often used to emphasize a particular
word, sentence, or particular part of a document.

junk email

the Junk Email Filter feature moves suspected incoming emails (spams) to the Junk Email folder
(a place used to store spam emails).

justify (full justification)
align text along the both left and right sides.
keyboard

an input device that allows a user to enter characters (letters, numbers, symbols, etc.) and
commands into a computer.

keyboarding skills
the ability to input information through a keyboard smoothly while typing.
laptop computer

a portable personal computer that is small enough to rest on the user's lap and can be powered by a
battery. It includes a flip down screen and a keyboard with a touchpad. Also known as a notebook.

left-click

press the left mouse button on the left side of the mouse. Left-click is often referred to as “regular-
click” and it is used for many common computer tasks, such as selecting objects, closing
windows, opening hyperlinks, double-clicking, etc.
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left-justification (flush left)

align text along the left side (ragged on the right).
line spacing

the space between lines of text in a paragraph / document.
link

a word, phrase, image, etc., within a file or web page that a user can click on to jump to another
document, section of the same document, or web page. Also known as a hyperlink.

Mac
a type of personal computer made by Apple Inc. Short for Macintosh.
machine language

a low-level programming language comprised of a collection of binary digits (ones and zeros) that
the computer can read and understand.

magnetic core

uses arrays of small rings of magnetized material called cores to store information.
magnetic drum

a cylinder coated with magnetic material, on which data and programs can be stored.
mainframe computer

a high-performance computer used for large information processing jobs.
malware

a software that is designed to damage, disrupt, or infect computers.
memory

a physical device that is used to store data, information, and programs in a computer.
microprocessor

an electronic component held on an integrated circuit that contains a computer's central processing
unit (CPU) and other associated circuits.
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Microsoft Office

a group of productivity software applications developed by Microsoft Corporation. Microsoft
Office 2016 includes such programs as Microsoft Word, Microsoft Excel, Microsoft PowerPoint,
etc.

minicomputer

a mid-range computer that is intermediate in size, power, speed, storage capacity, etc., between a
mainframe and a microcomputer.

motherboard

the main circuit board of a computer; also known as the mainboard.
mouse

a hand-held pointing device that can control the position of a cursor on a display screen.
moving

move the original files or folder from one place to another (change the destination).
online communication

the sharing of information or communication over a computer network.
operating system (OS)

a software that controls and coordinates the computer hardware devices and runs other software
and applications on a computer. It is the main part of system software and a computer will not
function without it.

output device

a piece of hardware device that receives information from a computer.
page break

a page break marks the end of a page that indicates where the printer will start a new page.
page layout

the arrangement of text, graphics, pictures, and other elements on a page. It describes how each
page of a document will appear when it is printed.

page numbers

Word supports automatically adding page numbers in a multi-page document.
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personal computer

a small computer designed for use by a single user at a time. Also known as a PC or a
microcomputer.

phishing

when an Internet scammer uses deceptive emails or websites to try to obtain valuable personal
information from people.

point and click

point an object on the screen and then press a button on the mouse to select objects / commands,
open menus / hyperlinks (links), or close windows.

pointing device
a device used to control the movement of the pointer (cursor) on the screen.
presentation program

a program that is designed to present information in the form of a slideshow, using multimedia
formats such as pictures, sounds, videos, and text.

printer
an output device linked to a computer that transfers the information (text, images, etc.) to paper.
RAM (random-access memory)

a type of data storage (memory element) used in computers that temporarily stores programs and
data. RAM is a kind of volatile memory, meaning its contents are lost when the computer is turned
off.

reboot
to shut down and restart a computer, allowing its operating system and programs to be reloaded.
ribbon

a group of buttons and icons (tabs) at the top of the window that allows users to access the
commands that they need to complete a task.

right-click

press the right mouse button on the right side of the mouse to display a popup menu showing
commands for a selected item.
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right-justification (flush right)
align text along the right side (ragged on the left).
ROM (read-only memory)

a type of data storage used in computers that permanently stores data and programs. ROM is a
kind of non-volatile memory, meaning its contents are retained even when the computer is turned
off.

router
a device that transfers data between computer networks to provide access to the Internet.
ScreenTip (ToolTip)

a small text box (a hint) appears when the mouse point rest on a command, icon, button, etc. It
displays the name of the item and sometimes a brief description of its function and the shortcut
key for the command.

scrolling

sliding content (text, images, etc.) vertically or horizontally on a computer screen and allowing the
user to view different parts of information in a window.

search engine

a web-based tool that is designed to search the content of web pages and find particular
information on the Internet.

section break

a section break splits a page into sections that can have a different format or layout within the
same page in the document.

sent

an email folder that saves copies of emails that you have sent.

server

a central computer that provides information to other computers.
smartphone

a mobile phone that performs many of the functions of a personal computer.
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social networking
the use of websites and other Internet services to communicate with other people.
software

a set of instructions or programs that tells a computer what to do or how to perform a specific task
(computer software runs on hardware).

spreadsheet

a program that organizes data into rows and columns, also known as tabular form. This data can
then be arranged, sorted, calculated (using formulas and functions), analyzed, or illustrated using
graphical representations.

spyware

a software that secretly monitors (spies) a user’s online behaviour and gets sensitive information
about a person or organization without the user’s knowledge.

supercomputer

a powerful computer that can process large amounts of data and do a great amount of computation
very quickly.

system software

it is designed to run a computer's hardware and application software, and make the computer
system available for use. It serves as the interface between hardware, application software, and the
user.

system unit
the main part of a desktop computer (the case) that contains all of the main electronic components.
tab selector (tab indicator)

a small button located in the left corner of the horizontal ruler that supplies the user with
a variety of tab marker (tab stop) options (left, right, center, etc.).

tab stop
a location where the cursor (insertion point) would stop when the Tab key is pressed.
table

information arranged in a condensed form of columns and rows. It is a more effective way to
present information.
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tablet

a wireless touchscreen PC that is slightly smaller and weighs less than the average laptop.
text justification / alignment

refers to how the left and right edges of a paragraph align on a page.
touch typing

a method of typing (with all the available fingers) without looking at the keyboard.
trackpad

a small, flat surface on a laptop or other computer that does the same things as a mouse.
transistor

an electronic component that can be used as an amplifier or as a switch. It is used to control the
flow of electricity in radios, televisions, computers, etc.

Trojan horse

(or Trojan) a type of malware that looks harmless but can cause harm to a computer system.
underline

add a line underneath the text, in order to show its importance and draw attention to the text.
URL

Short for Uniform Resource Locator. A web address of a specific web page or file on the Internet.
USB drive

a small, portable storage device used to store or transfer data for computers; often used for the
storage, data backup, and transfer of computer files.

utility software

a type of system software that helps set up, analyze, configure, strengthen, maintain a computer
and performs a very specific task (e.g. antivirus software, backup software, memory tester, screen
saver, etc.).

vacuum tube

an electronic device that controls the flow of electrons in a vacuum. It used as a switch, amplifier,
or display screen in many older model radios, televisions, computers, etc.
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vertical scroll bar

a vertical bar on the right side of a window or screen that allows the user to scroll the window
viewing area up or down.

vertical scrolling
sliding content up or down on a computer screen using a vertical scroll bar.
video conferencing

a live video-based meeting between two or more users in different locations conducted by
transmitting audio and video data in real time.

VoIP
a telephone connection over the Internet.
word processing

the use of a program (software application) running on a computer to create, edit, format, and
store documents.

word processor

a program that allows users to create, save, edit, format, print, and retrieve documents.

World Wide Web

a system of Internet servers that is made from millions of interlinked websites and web pages.
Abbreviated as WWW or the web.

worm

a type of virus designed to quickly self-replicate and spread copies of itself from one computer to

another.
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Unit 8
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